# Table of contents

1 **Introduction**.........................................................................................................................................1  

2 **Setting up a development system** ......................................................................................................3  
2.1 Windows host..........................................................................................................................................3  
2.2 Linux host...............................................................................................................................................5  
2.2.1 Preparing your 64-bit Linux host .......................................................................................................5  
2.2.2 Installing UEIPAC software on your Linux host ..............................................................................5  
2.3 SDK directory layout ............................................................................................................................6  

3 **Configuring the UEIPAC** ......................................................................................................................7  
3.1 Connecting through the serial port .......................................................................................................7  
3.2 Root file system ......................................................................................................................................11  
3.2.1 Booting from the SD card ................................................................................................................11  
3.2.2 File-system corruption .....................................................................................................................11  
3.2.3 Setting-up a root file system as read-only .....................................................................................12  
3.2.4 Booting from a RAM disk ...............................................................................................................12  
3.2.5 Booting from an NFS share ...........................................................................................................15  
3.2.6 Revert to booting from an SD card ..................................................................................................16  
3.3 Configuring the Network ......................................................................................................................16  
3.3.1 Configuring a static IP address ........................................................................................................16  
3.3.2 Changing the default packet size (MTU) .......................................................................................17  
3.3.3 Configuring dynamic IP address (using a DHCP server) ...............................................................18  
3.3.4 Name resolution .............................................................................................................................18  
3.3.5 Connecting through Telnet ............................................................................................................18  
3.3.6 Connecting through SSH ...............................................................................................................19  
3.3.7 Configuring DHCP server ............................................................................................................19  
3.4 Configuring Date and Time .................................................................................................................19  
3.4.1 Changing the date ..........................................................................................................................19  
3.4.2 Changing the time zone ................................................................................................................20  
3.4.3 Connecting to an NTP server .........................................................................................................20  
3.5 Changing the password .......................................................................................................................21  
3.6 Configuring the web server ...............................................................................................................21  
3.7 System logger ........................................................................................................................................21  

4 **Transferring files** .................................................................................................................................22  
4.1 NFS .....................................................................................................................................................22  
4.2 FTP Client ..........................................................................................................................................22  
4.3 FTP Server ..........................................................................................................................................22  
4.4 SSH ...................................................................................................................................................22  
4.5 TFTP Client .........................................................................................................................................23
4.6 Windows shared directory.................................................................................................23
5 Connecting USB devices......................................................................................................24
  5.1 USB mass storage............................................................................................................24
  5.2 Wifi network interface....................................................................................................25
    5.2.1 Load kernel modules.................................................................................................26
    5.2.2 Connection to an open access point..........................................................................26
    5.2.3 Connection to an access point with WEP security....................................................27
    5.2.4 Connection to an access point with WPA/WPA2 security........................................27
    5.2.5 Direct connection to another computer in ad-hoc mode...........................................28
  5.3 UMTS/GSM modem......................................................................................................29
    5.3.1 Prerequisite..............................................................................................................29
    5.3.2 Manual configuration.................................................................................................29
    5.3.3 Automatic startup.....................................................................................................32
  5.4 Serial Port.....................................................................................................................32
    5.4.1 Load kernel modules.................................................................................................33
    5.4.2 Automatic startup.....................................................................................................33
  5.5 LibUSB..........................................................................................................................34
    5.5.1 Prerequisite..............................................................................................................34
    5.5.2 Write a program using libusb....................................................................................34
5 Serial Port........................................................................................................................35
  6.1 UEI Serial Server..........................................................................................................35
  6.2 Using the CPU layer’s serial port for general purpose....................................................37
7 Testing the I/O layers.........................................................................................................38
  7.1 devtbl..........................................................................................................................38
  7.2 Run examples................................................................................................................38
  7.3 PowerDNA server.........................................................................................................39
8 Application development...................................................................................................40
  8.1 Prerequisites................................................................................................................40
  8.2 Compiling and running Hello World...............................................................................40
  8.3 Debugging Hello World...............................................................................................41
  8.4 PowerDNA Library.......................................................................................................42
    8.4.1 PowerDNA API.........................................................................................................44
    8.4.2 Building and running the examples..........................................................................47
    8.4.3 Building your own program.....................................................................................48
  8.5 Real-Time Programming...............................................................................................48
  8.6 Running a program automatically after boot...............................................................50
  8.7 Running a program periodically..................................................................................51
9 Firmware installation and upgrade...................................................................................52
  9.1 Installing or upgrading the Linux kernel......................................................................52
    9.1.1 UEIPAC with Freescale 5200 CPU (100MBit Ethernet)..........................................52
9.1.2 UEIPAC with Freescale 8347 CPU (1GBit Ethernet) ................................................................. 53
9.2 Initializing an SD card .............................................................................................................. 53
  9.2.1 On a Linux PC ................................................................................................................. 53
  9.2.2 On the UEIPAC itself ....................................................................................................... 55
9.3 Running the standard DAQBios firmware ........................................................................... 56
  9.3.1 Configure UEIPAC with Freescale 5200 CPU to run DAQBios firmware ................. 56
  9.3.2 Configure UEIPAC with Freescale 5200 CPU to run Linux ........................................ 56
  9.3.3 Configure UEIPAC with Freescale 8347 CPU to run DAQBios firmware ................. 57
  9.3.4 Configure UEIPAC with Freescale 8347 CPU to run Linux ....................................... 57
10 Third-party software .............................................................................................................. 57
  10.1 Third-party libraries installed by default on UEIPAC ....................................................... 57
    10.1.1 zeromq .......................................................................................................................... 57
    10.1.2 libmodbus ................................................................................................................... 57
    10.1.3 expat ............................................................................................................................. 57
    10.1.4 sqlite ............................................................................................................................ 57
    10.1.5 gpd .................................................................................................................... 58
    10.1.6 GSL .............................................................................................................................. 58
    10.1.7 libusb .......................................................................................................................... 58
    10.1.8 mosquitto ....................................................................................................................... 58
    10.1.9 audiofile ...................................................................................................................... 58
  10.2 Building third-party software from source ...................................................................... 58
    10.2.1 Software with an autoconf configure script ............................................................... 58
    10.2.2 Other software ............................................................................................................. 59
Appendix A. Event API ............................................................................................................. A-1
  A.1 DqEmbConfigureEvent ...................................................................................................... A-1
  A.2 DqEmbWaitForEvent ......................................................................................................... A-1
  A.3 DqEmbCancelEvent .......................................................................................................... A-2
Appendix B. Using Eclipse IDE to program the UEIPAC .................................................. B-1
  B.1 Download and install Eclipse ............................................................................................. B-1
  B.2 Set up preferences .............................................................................................................. B-1
  B.3 Open and build examples .................................................................................................. B-2
  B.4 Download a program to target .......................................................................................... B-6
  B.5 Execute a program ............................................................................................................ B-14
  B.6 Debugging your program on the UEIPAC ........................................................................ B-16
Appendix C. Creating a new Eclipse project for UEIPAC ........................................... C-1
  C.1 Create a new project ........................................................................................................... C-1
  C.2 Configure the environment ............................................................................................... C-3
  C.3 Build and run ..................................................................................................................... C-4
  C.4 Adding DNA API calls to your program .......................................................................... C-13
Appendix D. Booting from NFS ............................................................................................ D-1

© Copyright 2017
United Electronic Industries, Inc. iii
508.921.4600
www.ueidaq.com
D.1  Configure shared RFS on host PC.................................D-1
D.2  Configure U-Boot......................................................D-1

Appendix E.  Building the Linux kernel.................................E-1
E.1  Download and patch Linux source..............................E-1
E.2  Configure and build the kernel for UEIPAC-300 and UEIPAC-600.....E-2
E.3  Configure and build the kernel for UEIPAC-300-1G, UEIPAC-600-1G and
      RACK versions.......................................................E-2

Appendix F.  Converting root file system to read only...............F-1
F.1  Modify RFS on SD card.............................................F-1
F.2  Configure U-Boot......................................................F-2

Appendix G.  Updating RAM disk image...............................G-1

Appendix H.  Bonding/Teaming Ethernet ports.......................H-1
1 Introduction

The UEIPAC extends the capability of the PowerDNA distributed data acquisition systems. With the UEIPAC, you can create programs that execute directly on PowerDNA or PowerDNR hardware. You can create standalone applications that don’t require a host PC to control and monitor your hardware.

On the UEIPAC, a Linux (or VxWorks) kernel replaces the standard “DAQBIOS” firmware in flash memory and uses an SD card as its local file system. This file system contains the other components of the operating system such as libraries, utilities, initialization scripts, and daemons. Note that this manual only applies to the Linux-based UEIPAC. Please refer to the UEIPAC-VxWorks manual to learn how to operate a VxWorks-based UEIPAC.

After power-up you have a ready to go Linux operating system with FTP and web servers, as well as a command line shell that is accessible from either the serial port or telnet and SSH over the network.

The UEIPAC can also be configured to execute user applications after booting-up.

User applications run as a regular Linux process giving you access to the standard POSIX API provided by the GNU C runtime library (glibc) as well as any other library that can be compiled for Linux, (for example, libxml, libaudiofile). See diagram 2.

The UEIPAC SDK includes a library dedicated for communicating with UEIPAC I/O boards and a subset of the hosted PowerDNA API, which allows reuse of existing example programs originally designed for hosted systems that communicate with PowerDNA hardware over a network.

Examples provided with the SDK can be updated to run directly on the UEIPAC with few modifications. See section 8.4 for more information.
Figure 1 UEIPAC Layered Architecture
2 Setting up a development system

The development system is composed of software tools necessary to create an embedded application targeting Linux on a PowerPC processor.

Development tools can run on a Linux PC or on a Windows PC using the Cygwin environment.

Provided development tools include the following:

- GCC cross-compiler targeting the UEIPAC PPC processor
- GNU toolchain tools, such as make
- Standard Linux libraries, such as glibc
- PowerDNA library for accessing the various PowerDNA data acquisition devices

2.1 Windows host

The UEIPAC cross-compiler depends on libraries provided by the Cygwin project.

Cygwin is a collection of tools that provide a Linux-like interface and environment for Windows OS and a DLL, which acts as a Linux API layer and provides substantial Linux API functionality.

Cygwin is available for free as an open source project. If you don’t have Cygwin already installed, download and run the installer setup_x86.exe from http://www.cygwin.com.

Alternatively, a commercial license (with technical support) can be purchased from Red Hat at http://www.redhat.com/services/custom/cygwin/

NOTE: UEIPAC software is only compatible with the 32-bit release of Cygwin. When installing from www.cygwin.com, make sure you select setup_x86.exe (do not use setup_x64.exe).

Running setup_x86.exe will install or update Cygwin. Note that the UEIPAC SDK requires three Cygwin packages from the following categories (network utility packages are listed as optional but are referred to in this manual):

- Base: tar and gzip packages are required.
- Devel: the make package is required.
- Net: network utility packages such as ftp, tftp, openssh and telnet are optional.
The Cygwin setup window provides a **Search** box, which can be used to find the listed packages and verify they are enabled (see Figure 2).

![Figure 2 Cygwin Setup Window](image)

To install the UEIPAC SDK on a Windows host:

1. Insert the “UEIPAC SDK” CDROM in your CD drive, and then open a Cygwin command line shell.

2. Change directory to the CD’s root directory (the example below assumes that the CDROM is the D: drive):
   ```bash
   cd /cygdrive/d
   ./install.sh
   ```

The UEIPAC installer modifies the `.bash_profile` file by adding the path of the UEIPAC cross-compiler to your PATH variable and creating a new environment variable, **UEIPACROOT**, which contains the UEIPAC software installation directory.
To activate the changes to the .bash_profile immediately, you can either close the terminal window and open a new one or type the command below:

source ~/.bash_profile

2.2 Linux host

2.2.1 Preparing your 64-bit Linux host
The UEIPAC cross-compiler is a 32-bit program. Note that the cross-compiler requires 32-bit run-time libraries to be installed to run on a 64-bit Linux host.

- Under Ubuntu, use the following command to install libraries:
  
sudo apt-get install lib32z1

- Under RedHat, CentOS or Fedora, use the following command to install libraries:
  
sudo yum install glibc.i686 zlib.i686

2.2.2 Installing UEIPAC software on your Linux host
To install the UEIPAC SDK on a Linux host, insert the “UEIPAC SDK” CDROM in your CD drive. You might need to mount it if your Linux distribution doesn’t detect the CDROM automatically.

To mount the CDROM, type:

mount /dev/cdrom /mnt/cdrom

To install from mounted CDROM:

bash install.sh

The UEIPAC installer modifies the .bash_profile file by adding the path of the UEIPAC cross-compiler to your PATH variable and creating a new environment variable, UEIPACROOT, which contains the UEIPAC software installation directory:

#PowerDNA setup: This line was added by the UEIPAC install script
PATH=$PATH:"/home/frederic/uei/ueipac-2.6.0/powerpc-604-linux-gnu/bin"
export PATH
UEIPACROOT="/home/frederic/uei/ueipac-2.6.0"
export UEIPACROOT
#PowerDNA setup end

The .bash_profile file is automatically sourced at login.

To activate the changes to the .bash_profile immediately, you can either logout and log back in or type the command below:

source ~/.bash_profile
You will need to manually update PATH and create **UEIPACROOT** if your Linux PC is using a different shell interpreter than **bash**.

For example:
- If you are using **csh**, insert PATH and UEIPACROOT in `~/.login`
- If you are using **dash**, insert PATH and UEIPACROOT in `~/.profile`

### 2.3 SDK directory layout

The following directories and files are included in the SDK file structure:
- **bin**: command line utilities not installed by default on the UEIPAC SD card (mostly Xenomai test programs)
- **doc**: manuals in PDF and HTML format
- **include**: UEIPAC SDK header files
- **kernel**: kernel source code, build scripts, and binary images
- **lib**: UEIPAC SDK shared and static libraries
- **powerpc-604-linux-gnu**: GCC cross compiler
- **rfs**: archive containing the root file system installed on the SD card
- **sdk**: UEIPAC software development kit
3 Configuring the UEIPAC

Your PowerDNA/PowerDNR hardware must be pre-configured to run Linux. Hardware configuration includes:
- A Linux kernel loaded in flash memory
- An SD card containing the root file system inserted in the SD card slot

Contact UEI to convert your PowerDNA/PowerDNR hardware to a UEIPAC if it is configured with the standard “DAQBIOS” firmware.

3.1 Connecting through the serial port

Note that the serial port on the CPU layer is used as a console by default. If needed, you can reconfigure the serial port for use as a general purpose serial port (see section 6.2).

To connect through the serial port:

1. Connect the serial cable to the serial port on the UEIPAC and the serial port on your PC.

   You will need a serial communication program:
   - Windows: ucon, MTTY, PuTTY or HyperTerminal.
   - Linux: minicom, kermit or cu (part of the uucp package).

   The UEIPAC uses the serial port settings: 57600 bits/s, 8 data bits, 1 stop bit and no parity.

2. Run your serial terminal program and configure the serial communication settings accordingly.

3. Connect the DC output of the power supply (24VDC) to the “Power In” connector on the UEIPAC and connect the AC input on the power supply to an AC power source.

Once power is connected, you should see a message similar to the following on your serial console:

U-Boot 1.1.4 (Jan 10 2006 - 19:20:03)

CPU: MPC5200 v1.2 at 396 MHz
    Bus 132 MHz, IPB 66 MHz, PCI 33 MHz

Board: UEI PowerDNA MPC5200 Layer
I2C: 85 kHz, ready
DRAM: 128 MB
Reserving 349k for U-Boot at: 07fa8000
FLASH: 4 MB
In: serial
Out: serial
Err: serial
Net: FEC ETHERNET

Type "run flash_nfs" to mount root filesystem over NFS

Hit any key to stop autoboot: 5

The console messages are generated from the system U-Boot boot loader. The boot loader pauses for 2 seconds to give the user a chance to alter the configuration, if necessary.

After the countdown ends, U-Boot loads the Linux kernel from flash, uncompresses it, and starts it:

U-Boot 1.1.4 PowerDNA 3.2.1 (Dec 18 2006 - 10:41:01)

CPU: MPC5200 v1.2 at 396 MHz
     Bus 132 MHz, IPB 66 MHz, PCI 33 MHz

Board: UEI PowerDNA MPC5200 Layer
I2C: 85 kHz, ready
DRAM: ..........128 MB
FLASH: 4 MB
In: serial
Out: serial
Err: serial
Net: FEC ETHERNET

Type "run flash_nfs" to mount root filesystem over NFS

Hit any key to stop autoboot: 0
## Booting image at ffd80000 ...

Image Name: Linux-2.6.28.5-ueipac5200
Created: 2009-05-01 14:31:47 UTC
Image Type: PowerPC Linux Kernel Image (gzip compressed)
Data Size: 1442840 Bytes = 1.4 MB
Load Address: 00400000
Entry Point: 004005e0
Verifying Checksum ... OK
Uncompressing Kernel Image ... OK
Using ueipac5200 machine description
Linux version 2.6.28.5-ueipac5200 (frederic@frederic-ubuntu64) (gcc version 4.0.2) #1 PREEMPT Fri May 1 10:31:32 EDT 2009
Zone PFN ranges:
  DMA       0x00000000 -> 0x00008000
  Normal    0x00008000 -> 0x00008000
  HighMem   0x00008000 -> 0x00008000
Movable zone start PFN for each node
  early_node_map[1] active PFN ranges
  0: 0x00000000 -> 0x00008000
Built 1 zonelists in Zone order, mobility grouping on. Total pages: 32512
Kernel command line: console=ttyPSC0,57600 root=62:1 rw
MPC52xx PIC is up and running!
PID hash table entries: 512 (order: 9, 2048 bytes)
clocksource: timebase mult[79364d9] shift[22] registered
I-pipe 2.4-04: pipeline enabled.
Console: colour dummy device 80x25
console [ttyPSC0] enabled
Dentry cache hash table entries: 16384 (order: 4, 65536 bytes)
Inode-cache hash table entries: 8192 (order: 3, 32768 bytes)
Memory: 126376k/131072k available (2808k kernel code, 4548k reserved,
116k data, 436k bss, 152k init)
Calibrating delay loop... 65.53 BogoMIPS (lpj=32768)
Mount-cache hash table entries: 512
net_namespace: 292 bytes
NET: Registered protocol family 16
DMA: MPC52xx BestComm driver
DMA: MPC52xx BestComm engine @f0001200 ok!
NET: Registered protocol family 2
IP route cache hash table entries: 1024 (order: 0, 4096 bytes)
TCP established hash table entries: 4096 (order: 3, 32768 bytes)
TCP bind hash table entries: 4096 (order: 2, 16384 bytes)
TCP: Hash tables configured (established 4096 bind 4096)
TCP reno registered
NET: Registered protocol family 1
audit: initializing netlink socket (disabled)
type=2000 audit(0.208:1): initialized
I-pipe: Domain Xenomai registered.
Xenomai: hal/powerpc started.
Xenomai: real-time nucleus v2.4.7 (Andalusia) loaded.
Xenomai: starting native API services.
Xenomai: starting POSIX services.
Xenomai: starting RTDM services.
VFS: Disk quotas dquot_6.5.1
Dquot-cache hash table entries: 1024 (order 0, 4096 bytes)
msgmni has been set to 247
io scheduler noop registered
io scheduler anticipatory registered (default)
io scheduler deadline registered
io scheduler cfq registered
Generic RTC Driver v1.07
Serial: MPC52xx PSC UART driver
f0002000.serial: ttyPSC0 at MII0 0xf0002000 (irq = 129) is a MPC52xx
PSC
brd: module loaded
loop: module loaded
net eth0: Fixed speed MII link: 100FD
MPC52xx SPI interface probed at 0xf0000f00, irq0=141, irq1=142
mpc52xx_spi_init_mmc: SDCard is now ready
mpc52xx_mmc0: p1
mice: PS/2 mouse device common for all mice
TCP cubic registered
NET: Registered protocol family 17
EXT2-fs warning: mounting unchecked fs, running e2fsck is recommended
VFS: Mounted root (ext2 filesystem).
Freeing unused kernel memory: 152k init
init started: BusyBox v1.13.3 (2009-04-13 15:41:06 EDT)
loading modules
   pdnabus
   pdnadev
Starting Network...
Checking Network Configuration: [ OK ]
Loading Static Network Interface: [ OK ]
Checking Network Connection: [ OK ]
Starting inetd... [ OK ]
Starting local script...
PowerDNA Driver, version 2.1.0

<table>
<thead>
<tr>
<th>Address</th>
<th>Iqr</th>
<th>Model</th>
<th>Option</th>
<th>Phy/Virt</th>
<th>S/N</th>
<th>Pri</th>
<th>LogicVer</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xc9080000</td>
<td>7</td>
<td>201</td>
<td>100</td>
<td>phys</td>
<td>0027153</td>
<td>0</td>
<td>02.09.03</td>
</tr>
<tr>
<td>0xc9090000</td>
<td>7</td>
<td>308</td>
<td>1</td>
<td>phys</td>
<td>0028647</td>
<td>0</td>
<td>02.0e.00</td>
</tr>
<tr>
<td>0xc90a0000</td>
<td>7</td>
<td>207</td>
<td>1</td>
<td>phys</td>
<td>0030353</td>
<td>0</td>
<td>02.0c.05</td>
</tr>
<tr>
<td>0xc90b0000</td>
<td>7</td>
<td>205</td>
<td>1</td>
<td>phys</td>
<td>0031210</td>
<td>0</td>
<td>02.09.03</td>
</tr>
<tr>
<td>0xc90c0000</td>
<td>7</td>
<td>403</td>
<td>1</td>
<td>phys</td>
<td>0034744</td>
<td>0</td>
<td>02.0e.00</td>
</tr>
<tr>
<td>0xc90d0000</td>
<td>7</td>
<td>503</td>
<td>1</td>
<td>phys</td>
<td>0025808</td>
<td>0</td>
<td>02.09.03</td>
</tr>
</tbody>
</table>

[ OK ]

BusyBox v1.13.3 (2009-04-29 09:50:58 EDT) built-in shell (ash)
Enter 'help' for a list of built-in commands.

~ #

After the boot loader completes, the Linux root prompt (#) will be available in the
command line of your serial terminal, allowing you to navigate the file system and enter
standard Linux commands, such as ls, ps, and cd.
3.2 Root file system

3.2.1 Booting from the SD card
The UEIPAC ships with the root file system entirely located on the SD card. It uses the EXT2 format.

It is recommended to type the “halt” command before powering down the UEIPAC and the “reboot” command to restart the UEIPAC.

If you power down the UEIPAC abruptly, the following message will appear at boot time:

EXT2-fs warning: mounting unchecked fs, running e2fsck is recommended

You must check the file system for errors with the following commands:
# mount -o remount,ro /
# e2fsck /dev/sdcard1
 e2fsck 1.38 (30-Jun-2005)
/dev/sdcard: clean, 702/124160 files, 6632/247872 blocks
# reboot

3.2.2 File-system corruption
Powering down the UEIPAC while it is writing data to a file can cause file system corruption even in a non-related part of the file system.

File corruption can affect files that never get written or even affect files marked as read-only.

The file-system will issue writes in a minimum size, typically 4KB, and a single 4KB block may have data in it that is part of two different files. Those two files might even be in different directories, or have different access permissions.

Thus, a simple write to a log file can result in a read and rewrite of part of any file on the partition. When power goes down in the middle of that rewrite, the result is silent data corruption.

File-systems also have to modify a lot of metadata in various places in order to just create a one byte file. A power failure during that operation could, for example, destroy the names of several other files.

There are three ways to set-up the UEIPAC to ensure that it survives an uncontrolled power failure:
• **Set-up the root file system on a read-only partition and store temporary files in a RAM disk**
  This method ensures that the UEIPAC will always boot unless the SD card itself becomes inoperable (because of wear out or random failure). However, it uses a small amount of additional memory for temporary file storage, (e.g., log files, lock files).

• **Load the root file system as a RAM disk**
  This method is more robust but consumes more memory (around 10 MBytes) and only works on UEIPAC 1G (Gigabit Ethernet) and R (RACK) models. With this method, the UEIPAC will even be able to boot without an SD card.

• **Load the root file system from an NFS share**
  This method requires a network server to always be on to provide the files. This method is good for development but not very useful for deployment.

Keeping system files in a read-only partition has proven reliable in multiple customer applications that incur frequent unscheduled power cycles. However, using a RAM disk is ultimately the most robust solution because the UEIPAC can boot even if the SD card is pulled or fails entirely.

### 3.2.3 Setting-up a root file system as read-only

See Appendix E for instructions on how to convert a read-write UEIPAC root file system to a read-only one.

### 3.2.4 Booting from a RAM disk

Booting from a RAM disk is faster than any other method; however, the RAM disk size is limited to 16Mbytes and any data written to the RAM disk is lost when the system shuts down or reboots.

The RAM disk is very useful if, for example, you want to reinitialize the SD card or want to use an NFS share for persistent storage.

The RAM disk can only fit in the flash memory of UEIPAC models based on the 8347 CPU (UEIPAC-1G, UEIPAC-R, or UEIPAC-F). The UEIPAC models based on the 5200 CPU need to upload the RAM disk image via TFTP each time they boot.
3.2.4.1 Customizing the RAM disk image

Customizing the RAM drive image is necessary to:

- add your program files to the disk image
- change the default IP address
- tweak the startup script if you wish to start a program automatically

Customization can only be done on a Linux PC. Some versions of Linux might require you to install the uboot mkimage utility to proceed with the customization procedure.

- To install uboot mkimage under Ubuntu or Debian, type:
  
  `$ sudo apt-get install uboot-mkimage`

To customize the RAM disk image, do the following:

1. Extract compressed RAM disk image from the uImage file. The following command converts the `uRamdisk-x.y.z` file to `ramdisk.gz`

   `$ dd if=uRamdisk-x.y.z bs=64 skip=1 of=ramdisk.gz`

2. Uncompress RAM disk image

   `$ gunzip -v ramdisk.gz`

   `ramdisk.gz: 66.6% -- replaced with ramdisk`

3. Mount RAM disk image

   `$ mount -o loop –t ext2 ramdisk /mnt`

Now files in the `/mnt` directory can be added, removed, or modified.

Once you are done, you can re-pack the RAM disk into a U-Boot image:

1. Unmount RAM disk image:

   `$ umount /mnt`

2. Compress RAM disk image:

   `$ gzip -v9 ramdisk`

   `ramdisk: 66.6% -- replaced with ramdisk.gz`

3. Create new U-Boot image:

   `$ mkimage -T ramdisk -C gzip -n 'My UEISIM RAM disk' -d ramdisk.gz`

   `new-uRamdisk-x.y.z`

   `Image Name: UEIPAC RAM disk`

   `Created: Wed Apr 11 17:32:41 2012`

   `Image Type: PowerPC Linux RAMDisk Image (gzip compressed)`

   `Data Size: 2425561 Bytes = 2368.71 kB = 2.31 MB`

   `Load Address: 0x00000000`

   `Entry Point: 0x00000000`
3.2.4.2  Loading the RAM disk image to flash

Follow the steps below to upload the RAM disk to memory and boot from it.

1. Copy the `<UEIP SDK>/rfs/uRamlisk-x.y.z` file to the root directory of your TFTP server.
2. Power-up your UEIPAC and press any key to enter U-Boot.
3. Configure the UEIPAC’s IP address:
   ```
   setenv ipaddr <IP address of the UEIPAC>
   ```
4. Configure U-Boot to use your host PC as TFTP server:
   ```
   setenv serverip <IP address of your host PC>
   ```
   **NOTE:** After uploading the RAM disk using `tftp`, the number of bytes transferred will print in the stdio messages. Note the number of bytes transferred.
5. Upload RAM disk:
   ```
   tftp 4000000 uRamlisk-x.y.z
   ```
   Console messages similar to the following will display in the serial window:
   ```
   => tftp 4000000 UserRamlisk-3.0.5
   from server 192.168.100.59; our IP address is 192.168.100.2 Filename 'UserRamlisk-3.0.5'.
   Load address: 0x4000000
   Loading:
   *#################################################################
   #################################################################
   <...
   ############
   done
   Bytes transferred = 11040149 (a87595 hex)
   ```
6. On 8347 based CPUs (-1G Cubes and –R/F RACK models), do the following to erase flash sectors and copy the RAM disk to flash:
   **NOTE:** The parameters for the flash erase command include the start address of the first sector and the end address of the last sector to erase. Flash sectors are erased in 128kB chunks. The start address is a constant, and the end address of the last sector is calculated based on the image size:
   ```
   Start address: FE200000
   Image size: number of bytes uploaded to the RAM disk in step 5. The image size is printed to the screen when the image is finished uploading.
   In the example in step 5, the image size is a87595 hex:
a. Add the image size to the base address to calculate the end address of the image.
   For example:
   FE200000(base address) + A87595(image size) = FEC87595(end address)

b. Round the end address to the nearest end sector boundary. Since sectors are in 128kB chunks (from 00000 to 1FFFF hex), the end sector boundary can be calculated by performing a logical OR of 1FFFF on the address calculated in step a.
   For example:
   FEC87595(end address) OR 1FFFF = FEC9FFFF (end sector boundary for image)

c. Erase the sectors from the base address to the end sector address:
   erase fe200000 fec9ffff

d. Copy image from RAM to flash:
   cp.b 4000000 fe200000 ${filesize}

7. Update the bootargs variable to tell the kernel that its root file system is a RAM disk:
   For UEIPAC 300, UEIPAC 600 models (based on 5200 CPU):
   setenv bootargs console=ttyPSC0,57600
   ramdisk_size=<your RAM disk size> root=/dev/ram0 rw
   For all other UEIPACs (1G Cubes and R/F RACK models based on 8347 CPU):
   setenv bootargs console=ttyS0,57600
   ramdisk_size=<your RAM disk size> root=/dev/ram0 rw

8. Change boot command to unpack the RAM disk in memory before starting the kernel:
   For UEIPAC 300, UEIPAC 600 models (based on 5200 CPU),
   RAM disk must be loaded from RAM
   setenv bootcmd bootm ffd50000 4000000
   For all other UEIPACs (1G Cubes and R/F RACK models based on 8347 CPU),
   RAM disk can be loaded from flash
   setenv bootcmd bootm fe000000 fe200000

9. Save environment to make changes permanent and reset:
   saveenv
   reset

3.2.5 Booting from an NFS share
It is also possible to use an NFS network share to hold the root file system instead of the SD card.
Refer to Appendix D. for instructions.

3.2.6  Revert to booting from an SD card
Follow the steps below to revert back to the default of booting from the SD card.

1. Power-up your UEIPAC and press any key to enter U-Boot.

2. Update the bootargs variable to tell the kernel that its root file system is an SD card:
   For UEIPAC 300, UEIPAC 600 models (based on 5200 CPU):
   Type:
   `setenv bootargs console=ttyPSC0,57600 root=62:1 rw`

   For all other UEIPACs (1G Cubes and R/F RACK models based on 8347 CPU):
   Type:
   `setenv bootargs console=ttyS0,57600 root=62:1 rw`

3. Change the boot command to start kernel from the SD card:
   For UEIPAC 300, UEIPAC 600 models (based on 5200 CPU):
   Type:
   `setenv bootcmd bootm ffd50000`

   For all other UEIPACs (1G Cubes and R/F RACK models based on 8347 CPU):
   Type:
   `setenv bootcmd bootm fe000000`

4. Save environment to make changes permanent and reset:
   `saveenv`
   `reset`

3.3  Configuring the Network

3.3.1  Configuring a static IP address
Your UEIPAC is configured at the factory with the static IP address 192.168.100.2 to be part of a private network.

You can change the IP address using the following command:
`setip <IP address>`

The IP address change takes effect immediately and is stored in the `/etc/network.conf` configuration file.
3.3.1.1 Configuring the auxiliary Ethernet port

Note that `setip` only configures eth0 on UEIPACs equipped with dual Ethernet controller (UEIPAC-600R/1200R, UEIPAC-300/600-1G, UEIPAC-400/1200-MIL, UEINET-PAC, and UEIPAC-400F).

To configure eth1, use `ifconfig`:
```
ifconfig eth1 <IP address>
```

Insert the `ifconfig` command in `/etc/rc.local` to make the change permanent upon reboot.

3.3.2 Changing the default packet size (MTU)

You can change the MTU parameter for an ethernet port (default MTU is 1500 bytes) with the `ifconfig` command.

For example, to change MTU for eth0 to 9000 bytes:
```
ifconfig eth0 mtu 9000
```

The command will generate an Invalid Argument message if you set the MTU value too high. The highest value tolerated on current hardware is 9500 bytes.

Insert the command in `/etc/rc.local` to make the change permanent upon reboot.
3.3.3 Configuring dynamic IP address (using a DHCP server)
If you have a DHCP server available, you can configure the UEIPAC to automatically fetch an IP address when it boots up:

- Edit the file `/etc/network.conf` and change the line:
  
  ```
  DHCP=no
  ```
  
  To:
  
  ```
  DHCP=yes
  ```

Note that setting `DHCP=yes` to enable DHCP configures eth0.

To configure DHCP on eth1 for UEIPACs equipped with dual Ethernet controller (UEIPAC-600R/1200R, UEIPAC-300/600-1G, UEIPAC-400/1200-MIL, UEINET-PAC, or UEIPAC-400F), use `udhcpc`:

```bash
udhcpc -i eth1 -s /etc/udhcp/default.script
```

After configuring DHCP on eth0 or eth1, you must restart the network to activate changes:

```
/etc/init.d/network restart
```

3.3.4 Name resolution
If your UEIPAC uses a static address, you need to edit the `/etc/resolv.conf` file to add the IP address of your DNS server.

If your UEIPAC uses DHCP, the `/etc/resolv.conf` file is automatically populated and name resolution will work immediately.

3.3.5 Connecting through Telnet
Once the IP address is configured, you can connect to the UEIPAC over the network instead of the serial port if you choose. Telnet is a network protocol that allows access between your host PC and the UEIPAC using the exact same command line interface as the serial connection.

Type the following command on your host PC, then login as “root”. The password is “root”.

```
telnet <UEIPAC IP address>
```

Type the command “exit” to logout.
3.3.6 Connecting through SSH
Type the following command on your host PC. The password is “root”.

```
ssh root@<UEIPAC IP address>
```

Type the command “exit” to logout.

You can avoid typing the password each time you login using SSH keys:

1. Create private and public SSH keys on your host PC
   
   `ssh-keygen -t rsa`

2. Copy the public key to ~/.ssh on the UEIPAC
   
   `scp ~/.ssh/id_rsa.pub root@<IP address>:/.ssh/authorized_keys`

   **NOTE:** If your UEIPAC does not have the ~/.ssh directory, the `scp` command will display an error message stating the directory does not exist. If that happens, telnet or SSH onto the UEIPAC, and type: `mkdir ~/.ssh`
   
   and then type the `scp` command again on your host PC.

3. You can now log on the UEIPAC using SSH without password

3.3.7 Configuring DHCP server
The UEIPAC comes with the minimal DHCP server, udhcpd. You can use it when the UEIPAC is a server to assign IP addresses to clients. This is useful when configuring UEIPAC as a wifi access point so that it can assign IP addresses to the wifi devices connecting to the access point.

Create an /etc/udhcpcd.conf file to specify the network interface that will lease the IP addresses and the block of IP addresses that will be leased.

```
# The start and end of the IP lease block
start 192.168.2.20
end 192.168.2.254

# The interface that udhcpd will use
interface eth0
```

3.4 Configuring Date and Time
3.4.1 Changing the date
The UEIPAC is equipped with a real-time clock chip that preserves the date and time settings when the UEIPAC is not powered.
By default, the date is set to the current date and time in the UTC (GMT) time zone.

To print the current date and time, use the following command:
```
date
```

To change the current date and time, use one of the following commands:
```
date –s MMDDhhmm
date –s YYYYMMDDhhmm.ss
```

As an example, “date –s 06021405” sets the new date to June second, 2:05 PM.

To make this change permanent upon reboot, save the date to the RTC chip with the following command:
```
hwclock –w –u
```

### 3.4.2 Changing the time zone

To set the time zone you need to set the environment variable `TZ`.

As an example, type the following to set `TZ`:
```
export TZ=EST5EDT,M3.2.0,M11.1.0
```

It will set the time zone to Eastern Time with daylight saving time starting on the Sunday(0) of the second week(2) of March(3) and ending on Sunday(0) of the first week(1) of November(11).

To make this change permanent upon reboot, add the command to the `/etc/profile` file.

You can find a detailed explanation on the syntax of `TZ` at:

### 3.4.3 Connecting to an NTP server

The “rdate” utility can be used to retrieve the time from an NTP server.

The following command prints the time returned by the NTP server:
```
rdate –p <NTP server IP address>
```

The following command changes the UEIPAC current date and time to match the ones returned by the NTP server:
```
rdate –s <NTP server IP address>
```

To make this change permanent upon reboot, save the date to the RTC chip with the following command:
hwclock –w -u

3.5 Changing the password
Type the following command and enter your new password two times when prompted:
`passwd`

You can now logout and login with your new password.

3.6 Configuring the web server
The UEIPAC comes enabled with a simple web server. HTML pages can be copied to the folder `/www` to make them accessible from a remote web browser.

3.7 System logger
UEIPAC is configured with the system logger disabled by default to avoid unnecessary access to the file system.

You can enable the system logger after adding the `syslogd` command to `/etc/rc.local`:
Log messages will be written to the `/var/log/messages` file.

You can also enable the kernel logger to log all kernel messages (which are by default printed on the serial console) after adding the `klogd` command to `/etc/rc.local`

Lastly, to write your own messages to the system logger, include `<syslog.h>` in your program and call the POSIX APIs `openlog()`, `syslog()`, and `closelog()`.

Note that `syslogd` won’t work on a read-only file system because it needs to create a socket in `/dev` (/dev/log). A solution to this issue is to create a symbolic link named `/dev/log` that references a file in the /tmp folder.

```bash
ln -s /dev/log /tmp/.devlog
```
4 Transferring files

You can use any of the NFS, FTP, SSH or TFTP protocols to transfer files between your host PC and the UEIPAC.

4.1 NFS

If you have a NFS server running on your development machine, you can mount a shared directory on the UEIPAC. This will make the shared directory available on the UEIPAC local file system.

To mount a shared directory (for example /shared located on host at 192.168.100.1 mounted on /mnt):

```
mount -o nolock -t nfs 192.168.100.1:/shared /mnt/nfs_share
```

After typing this command, all files present in the host PC directory /shared will also be accessible on the UEIPAC’s /mnt/nfs_share directory.

4.2 FTP Client

To connect to an external FTP server from the UEIPAC, use the commands “ftpput” and “ftpget”.

To retrieve a file from an FTP server:

```
ftpget -u <username> -p <password> <FTP server IP address> <local file name> <remote file name>
```

To send a file to an FTP server:

```
ftpput -u <username> -p <password> <FTP server IP address> <remote file name> <local file name>
```

4.3 FTP Server

The UEIPAC comes with the vsftpd FTP server. The server is active by default.

You can login as “root” with password “root”. Logging in as root provides read and write access to the entire file system.

4.4 SSH

The UEIPAC also comes with the dropbear SSH server preinstalled.

Use the command scp to transfer a file between your PC and the UEIPAC.
To send a file to the UEIPAC:
   scp <source file path on PC> root@192.168.100.2:<destination path on UEIPAC>

To receive a file from the UEIPAC:
   scp root@192.168.100.2:<source file path on UEIPAC> <destination path on PC>

4.5 TFTP Client
To retrieve a file from a TFTP server, use the following command:
   tftp –g –r <remote file name> <TFTP server IP address>

4.6 Windows shared directory
To mount a directory shared by a Windows computer or a Network Attached Storage (NAS), do the following:

1. Load the cifs kernel module:
   modprobe cifs

2. Mount the network share:
   mount -t cifs //hostip/share /mnt -o username=<user>,password=<pass>
5 Connecting USB devices

You can only connect USB devices to PowerDNA Cubes or PowerDNR RACKs equipped with a USB type A connector.

![Type A USB connector](image)

The Linux kernel supports most USB devices, but the UEIPAC only comes with drivers for USB mass storage devices to save space on the SD card.

Please contact UEI if you plan to use any other USB device.

5.1 USB mass storage

USB mass storage devices use multiple form factors. They range from the smallest USB flash drive to enclosures used to connect ATA or SATA hard-drives.

The UEIPAC supports all USB mass storage devices that comply with the USB mass storage device class and are formatted with one of the following formats: FAT, EXT2.

After connecting a mass storage device to the UEIPAC, the following kernel messages will appear on the serial console (if you are connected using telnet or SSH, use the command `dmesg` to view kernel messages):

```
usb 1-1: new high speed USB device using fsl-ehci and address 2
usb 1-1: configuration #1 chosen from 1 choice
scsi0 : SCSI emulation for USB Mass Storage devices
usb 1-1: New USB device found, idVendor=08ec, idProduct=0011
usb 1-1: New USB device strings: Mfr=1, Product=2, SerialNumber=3
usb 1-1: Product: USB Drive
usb 1-1: Manufacturer: Fujifilm
usb 1-1: SerialNumber: 0713B317290025CC
```

Load the USB storage kernel driver with the command below:
```
~# modprobe usb-storage
```

Note that you must append the string `usb-storage` at the end of the `/etc/modules` file to automatically load this kernel module at boot time.

This should display kernel messages similar to the messages below:
[ 288.462755] Initializing USB Mass Storage driver...
[ 288.473169] scsi0 : usb-storage 1-1:1.0
[ 288.482325] usbcore: registered new interface driver usb-storage
[ 289.483586] scsi 0:0:0:0: Direct-Access SanDisk Cruzer 8.02 PQ: 0 ANSI: 0 CCS
[ 289.503867] sd 0:0:0:0: [sda] 62562239 512-byte logical blocks: (32.0 GB/29.8 GiB)
[ 289.522154] sd 0:0:0:0: [sda] Write Protect is off
[ 289.532494] sd 0:0:0:0: [sda] No Caching mode page present
[ 289.543548] sd 0:0:0:0: [sda] Assuming drive cache: write through
[ 289.559485] sd 0:0:0:0: [sda] Assuming drive cache: write through
[ 289.585852] sd 0:0:0:0: [sda] No Caching mode page present
[ 289.594927] sd 0:0:0:0: [sda] Assuming drive cache: write through
[ 289.605996] sd 0:0:0:0: [sda] Assuming drive cache: write through
[ 289.618236] sd 0:0:0:0: [sda] Attached SCSI removable disk

Note the device node name assigned to this USB device is in the format “sdxn”:
- x is a for the first drive, b for the second and so on.
- n is the partition number

The kernel message above shows that the USB mass storage device's first partition is using the device node sda1

You can mount the file system located on this device with the command:
\[ \text{mount } /dev/sda1 /mnt \]

The files are now accessible under the directory /mnt

You must unmount the file system before unplugging the device to avoid file corruption:
\[ \text{umount } /mnt \]

5.2 Wifi network interface
The UEIPAC comes with drivers for wifi network USB interfaces that use the following chipsets:
- Realtek RTL8187
- Ralink RT2570, RT2571
5.2.1 Load kernel modules

At the command line prompt type one of the following commands depending on your wifi chipset:

- `modprobe rtl8187`
- `modprobe rt200xusb`
- `modprobe rt2500usb`
- `modprobe rt73usb`

Wifi network interface names follow the format of `wlan0`, `wlan1`, etc.

The `iwconfig` utility is used to configure wifi communication parameters.

You can verify that your interface was properly detected by typing the command `iwconfig`. A new entry `wlan0` should appear:

```
lo        no wireless extensions.
eth0      no wireless extensions.
eth1      no wireless extensions.
wmaster0  no wireless extensions.
wlan0     IEEE 802.11bg  ESSID:"
           Mode:Managed  Frequency:2.412 GHz  Access Point: Not-Associated
           Tx-Power=0 dBm
           Retry min limit:7   RTS thr:off   Fragment thr=2352 B
           Encryption key:off
           Power Management:off
           Link Quality:0  Signal level:0  Noise level:0
           Rx invalid nwid:0  Rx invalid crypt:0  Rx invalid frag:0
           Tx excessive retries:0  Invalid misc:0   Missed beacon:0
```

5.2.2 Connection to an open access point

To connect to an open access point, use the following procedure:

1. Specify that you want to connect as a client to a network with an access point:
   ```
iwconfig wlan0 mode managed
   ```

2. Set the ESSID of the access point:
   ```
iwconfig wlan0 essid <name of your access point>
   ```

3. Bring up wifi interface:
   ```
ifconfig wlan0 up
   ```
4. You can now scan the access points accessible by your wifi interface:
   \texttt{iwlist wlan0 scan}

5. If there is a DHCP server on your network, get an IP address for your wifi interface:
   \texttt{udhcpc -i wlan0 -s /etc/udhcp/default.script}
   Otherwise, assign a static IP address to your wifi interface:
   \texttt{ifconfig wlan0 192.168.100.3 netmask 255.255.255.0}
   \texttt{route add default gateway 192.168.100.1}

5.2.3 Connection to an access point with WEP security

The procedure is almost identical to connecting to an open access point. In addition, you need to specify your WEP key:
   \texttt{iwconfig wlan0 key \texttt{<WEP key in hexadecimal>}}

128-bit WEP uses 26 hex characters, and 64-bit WEP uses 10.

5.2.4 Connection to an access point with WPA/WPA2 security

1. Generate the pre-shared key using the password of the access point.
   \texttt{wpa_passphrase \texttt{<name of your access point>} \texttt{<access point password>}}

2. Edit the \texttt{/etc/wpa_supplicant.conf} file and update the following fields:
   \begin{itemize}
   \item \texttt{ssid} : the ID of your access point
   \item \texttt{psk} : the pre-shared key generated with \texttt{wpa_passphrase}
   \item \texttt{proto} : 
     \begin{itemize}
     \item \texttt{WPA} for WPA security and \texttt{RSN} for WPA2 security
     \end{itemize}
   \item \texttt{key_mgmt} : \texttt{WPA-PSK}
   \item \texttt{pairwise} : \texttt{TKIP} for WPA and \texttt{TKIP CCMP} for WPA2
   \item \texttt{group} : \texttt{TKIP} for WPA and \texttt{TKIP CCMP} for WPA2
   \end{itemize}
The following is an example /etc/wpa_supplicant.conf file:
```plaintext
ctrl_interface=/var/run/wpa_supplicant
ctrl_interface_group=0
ap_scan=1

network={
    ssid=<put your access point ESSID here>
    proto=WPA
    key_mgmt=WPA-PSK
    pairwise=TKIP
    group=TKIP
    psk=<put pre-shared key generated with wpa_passphrase here>
    priority=2
}
```

3. Specify that you want to connect as a client to a network with an access point in managed mode:
   iwconfig wlan0 essid <name of your access point> mode managed

4. Run wpa_supplicant in daemon mode to authenticate with the access point:
   wpa_supplicant -iwlan0 -c/etc/wpa_supplicant.conf -Dwext -B

5. Run iwconfig to verify that the authentication worked:
   wlan0  IEEE 802.11bg  ESSID:"fred"
   Mode:Managed  Frequency:2.447 GHz  Access Point: 00:13:10:AA:FA:10
   Bit Rate=1 Mb/s  Tx-Power=27 dBm
   Retry min limit:7   RTS thr:off   Fragment thr:2352 B
   Power Management:off
   Link Quality=80/100  Signal level:-31 dBm
   Rx invalid nwid:0  Rx invalid crypt:0  Rx invalid frag:0
   Tx excessive retries:0  Invalid misc:0  Missed beacon:0

6. If there is a DHCP server on your network, get an IP address for your wifi interface:
   udhcpc -i wlan0 -s /etc/udhcp/default.script

   Otherwise, assign a static IP address to your wifi interface:
   ifconfig wlan0 192.168.100.3 netmask 255.255.255.0
   route add default gateway 192.168.100.1

5.2.5 Direct connection to another computer in ad-hoc mode

1. Specify that you want to connect in ad-hoc mode:
   iwconfig wlan0 mode ad-hoc
2. Set the ESSID of the access point:
   iwconfig wlan0 essid <name of your access point>

3. Bring up wifi interface:
   ifconfig wlan0 up

4. If there is a DHCP server on your network, get an IP address for your wifi interface:
   udhcpc –i wlan0 –s /etc/udhcp/default.script

   Otherwise, assign a static IP address to your wifi interface:
   ifconfig wlan0 192.168.100.3 netmask 255.255.255.0
   route add default gateway 192.168.100.1

5.3 UMTS/GSM modem

The UEIPAC comes with drivers for Sierra Wireless modems and supports USB modems connected to the UEIPAC USB port and embedded mini PCI Express modems connected to a CAR-550 carrier card.

Information in this section is based on using a Sierra wireless MC8790 card, which offers UMTS/HSPA and quad-band GSM/GPRS/EDGE network access for roaming on high-speed networks worldwide.

5.3.1 Prerequisite

You need to purchase a data plan with a cell phone provider that supports UMTS and/or GSM/GPRS.

- ATT and T-Mobile provide such a service in the USA.

Once you purchased a data plan, you will receive a SIM card that you need to insert in the CAR-550 before being able to establish a connection.

Don't forget to activate your account as soon as you receive your SIM card (usually done over the phone or on-line).

5.3.2 Manual configuration

From the UEIPAC point of view, the wireless modem is seen as a serial port to which it can send Hayes AT commands as if it were an old fashion RTC modem.
UEIPAC uses the PPP software to control the modem and configure a network connection with your phone provider.

5.3.2.1  **Load kernel modules**

At the command line prompt, type the following commands:
```
modprobe sierra
modprobe ppp
```

You should see the following messages printed on the console:
```
~ # modprobe sierra
usbcore: registered new interface driver usbserial
usbserial: USB Serial Driver core
USB Serial support registered for Sierra USB modem
sierra 1-1:1.0: Sierra USB modem converter detected
usb 1-1: Sierra USB modem converter now attached to ttyUSB0
sierra 1-1:1.1: Sierra USB modem converter detected
usb 1-1: Sierra USB modem converter now attached to ttyUSB1
sierra 1-1:1.2: Sierra USB modem converter detected
usb 1-1: Sierra USB modem converter now attached to ttyUSB2
sierra 1-1:1.3: Sierra USB modem converter detected
usb 1-1: Sierra USB modem converter now attached to ttyUSB3
sierra 1-1:1.4: Sierra USB modem converter detected
usb 1-1: Sierra USB modem converter now attached to ttyUSB4
sierra 1-1:1.5: Sierra USB modem converter detected
usb 1-1: Sierra USB modem converter now attached to ttyUSB5
sierra 1-1:1.6: Sierra USB modem converter detected
usb 1-1: Sierra USB modem converter now attached to ttyUSB6
usbcore: registered new interface driver sierra
sierra: v.1.3.2:USB Driver for Sierra Wireless USB modems

~ # modprobe ppp
PPP generic driver version 2.4.2
```

5.3.2.2  **Configure provider**

The system is pre-configured to connect to AT&T network. If you are using a different provider, edit the `/etc/ppp/peers/gsm_chat` file:

1. Look for the following line:
   ```
   OK     'AT+CGDCONT=1,"IP","ISP.CINGULAR"
   ```
2. Replace it with the Access Point Name (APN) of you provider. For example T-mobile's APN is “epc.tmobile.com”, so the line in `/etc/ppp/peers/gsm_chat` becomes:

   OK 'AT+CGDCONT=1,"IP","EPC.TMOBILE.COM"

See Table 1 for example APNs for several European countries.

### Table 1 Examples of Providers & Access Point Names

<table>
<thead>
<tr>
<th>Country</th>
<th>Provider</th>
<th>APN</th>
<th>Authentication</th>
<th>Phone Number</th>
<th>User</th>
<th>Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austria</td>
<td>A1</td>
<td>at+cgdcont=1,&quot;IP&quot;,&quot;a1.net&quot;</td>
<td>PAP/CHAP</td>
<td><em>99</em>**1#</td>
<td><a href="mailto:ppp@A1net.at">ppp@A1net.at</a></td>
<td>ppp</td>
</tr>
<tr>
<td>Belgium</td>
<td>Mobistar</td>
<td>at+cgdcont=1,&quot;IP&quot;,&quot;web.pro.be&quot;</td>
<td>Terminal based</td>
<td>*99#</td>
<td>mobistar</td>
<td>mobistar</td>
</tr>
<tr>
<td>France</td>
<td>Orange</td>
<td>at+cgdcont=1,&quot;IP&quot;,&quot;orange.fr&quot;</td>
<td>Terminal based</td>
<td><em>99</em>**1#</td>
<td>orange</td>
<td>orange</td>
</tr>
<tr>
<td>Germany</td>
<td>D2 Vodafone</td>
<td>at+cgdcont=1,&quot;IP&quot;,&quot;web.vodafone.de&quot;</td>
<td>PAP/CHAP</td>
<td><em>99</em>**1#</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td>Netherlands</td>
<td>KPN</td>
<td>at+cgdcont=1,&quot;IP&quot;,&quot;internet&quot;</td>
<td>Terminal based</td>
<td><em>99</em>**1#</td>
<td>Internet</td>
<td>none</td>
</tr>
<tr>
<td>Netherlands</td>
<td>Orange</td>
<td>at+cgdcont=1,&quot;IP&quot;,&quot;internet&quot;,&quot;,&quot;0,0</td>
<td>Terminal based</td>
<td><em>99</em>**1#</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td>Netherlands</td>
<td>Vodafone</td>
<td>at+cgdcont=1,&quot;IP&quot;,&quot;web.vodafone.nl&quot;</td>
<td>Terminal based</td>
<td>*99#</td>
<td>vodafone</td>
<td>vodafone</td>
</tr>
</tbody>
</table>

#### 5.3.2.3 Start PPP daemon

Issue the following command to start the PPP daemon and configure the network connection.

    /etc/init.d/pppd start

After a few seconds, the script will return, printing the message “[OK]” if it successfully configured the network connection or “[Failed]” if it did not.

    ~ # /etc/init.d/pppd start
    Starting pppd...PPP BSD Compression module registered
    PPP Deflate Compression module registered [  OK  ]

In case of failure, type the `dmesg` command to print the log and send that information to UEI technical support.

Type the command `ifconfig` to print the network connections currently configured on your UEIPAC. There should be three connections: local, eth0 and ppp0.

```
eth0 Link encap:Ethernet  HWaddr 00:0C:94:00:C5:CB
inet addr:192.168.100.2  Bcast:192.168.100.255
    Mask:255.255.255.0
```
Verify that ppp0 was assigned an IP address.

You can now connect to the internet from your UEIPAC.

5.3.3 Automatic startup

To automatically load the kernel modules, edit the /etc/modules file and add the following lines at the end of the file:

```bash
sierra
ppp
```

To automatically start the ppp daemon, add a symbolic link to /etc/init.d/pppd in the /etc/rc.d directory using the following command:

```bash
ln -s /etc/init.d/pppd /etc/rc.d/S30pppd
```

5.4 Serial Port

The UEIPAC comes with a driver for USB-serial devices based on the Prolific PL-2303 chipset.
5.4.1 Load kernel modules

At the command line prompt, type the following:

```
modprobe pl2303
```

You will see the following messages printed on the serial console (type `dmesg` to see those messages when logged in via telnet or SSH):

```
usbcore: registered new interface driver usbserial
USB Serial support registered for generic
usbserial: USB Serial Driver core
USB Serial support registered for pl2303
pl2303 1-5.1:1.0: pl2303 converter detected
usb 1-5.1: pl2303 converter now attached to ttyUSB0
usbcore: registered new interface driver ttyUSB0
pl2303: Prolific PL2303 USB to serial adaptor driver
```

Make note of the device node attached to the serial port. In the example above, it is `/dev/ttyUSB0`.

You will use this device node to address the serial port. Refer to the `SampleLinuxSerialPort` sample for example C code showing how to program a standard Linux serial port. Sample code can be found in the following directory:

- `<PowerDNA-x.y.z>/sdk/DAQLib_samples`

5.4.2 Automatic startup

To automatically load the kernel modules, edit the `/etc/modules` file and add the following lines at the end of the file:

```
pl2303
```
5.5 LibUSB

The UEIPAC comes with the LibUSB library to facilitate programming of USB devices for which there is no driver.

It allows the enumeration of USB devices as well as access to USB communication pipes:

- control transfers which are typically used for command or status operations
- interrupt transfers which are initiated by a device to request some action from the host
- isochronous transfers which are used to carry data the delivery of which is time critical (such as for video and speech)
- bulk transfers which can use all available bandwidth but are not time critical

5.5.1 Prerequisite

LibUSB uses usbfs which is a filesystem specifically designed for USB devices. Once this filesystem is mounted, it can be found at `/proc/bus/usb/`. It consists of information about all the USB devices that are connected to the computer.

LibUSB makes use of this filesystem to interact with the USB devices.

5.5.1.1 Mount USBFS manually

Type the following command to mount USBFS:

```
mount -t usbdevfs none /proc/bus/usb
```

5.5.1.2 Mount USBFS automatically

Add the following line to `/etc/fstab` to automatically mount USBFS at boot time:

```
none /proc/bus/usb usbfs defaults 0 0
```

5.5.2 Write a program using libusb

The UEIPAC ships with a simple example showing how to enumerate USB devices and query information: `SampleLibUSB`.

LibUSB API documentation is available at [http://www.libusb.org](http://www.libusb.org).
6 Serial Port

6.1 UEI Serial Server

UEI Serial Server makes PowerDNx serial devices (such as SL-501 and SL-508) accessible as standard Linux serial ports that can be programmed using the POSIX termios API.

The mapping configuration file is a text file with a [settings] section for global parameters and a [ttyUEI??] section for each mapped serial port.

For example:

```
[settings]
timeoutms=1000
retrycount=4
pollperiodms=10

[ttyUEI0]
ipAddress=127.0.0.1
device=2
port=0
#mode: 0=RS-232, 1=RS-485HD, 2=RS-485-FD
mode=0
baudRate=9600
#parity: 0=none, 1=odd, 2=even
parity=0
#stop Bits: 0=no stop bit, 1=1 stop bit, 2=1.5 stop bit
stopBits=0
#data bits: 5,6,7 or 8 data bits
dataBits=8

[ttyUEI1]
ipAddress=127.0.0.1
device=2
port=1
mode=0
baudRate=57600
parity=1
stopBits=1
dataBits=7
```

This example configuration file configures the serial server to return an error if it cannot communicate with the IOM after `timeoutms` milliseconds. The server can retry communication for `retrycount` times before giving up. The server will periodically poll serial ports for new incoming data using the.
pollperiodms value to specify the period in milliseconds.

This file creates two virtual serial ports /dev/ttyUEI0 and /dev/ttyUEI1 to control physical ports 0 and 1 on device 2 located on the UEIPAC.

- /dev/ttyUEI0 is configured to run at 9600 bits per sec, no parity, no stop bits and 8 data bits
- /dev/ttyUEI1 is configured to run at 57600 bits per sec, parity odd, 1 stop bits and 7 data bits

Note that the communication settings are only default values. The serial port will be reconfigured to use whatever communication settings you specify when opening the port from your application.

Run the serial server with the following command:
```
ueiserialserver <config file name>
```

Once the server is started, you can use the /dev/ttyUEI?? nodes like any other serial port with the termios API or any other program designed to access serial ports.

The UEIPAC comes with microcom installed on the SD card. You can run microcom to test the serial ports.

Start the serial server with at least two configured ports: /dev/ttyUEI0 and /dev/ttyUEI1

For the following example, we will assume that the two serial ports are connected with a NULL modem cable.

Open two separate command line shells and start the microcom program for each of the Serial ports you wish to test:
```
microcom -s 19200 /dev/ttyUEI0
microcom -s 19200 /dev/ttyUEI1
```

If both serial ports are tied with a NULL modem cable, anything you type in one of the session will appear on the other session.
6.2 Using the CPU layer's serial port for general purpose

To use the CPU layer’s serial port for general purpose, edit the /etc/inittab file and add the ‘#’ character in front of the line:

ttyS0::respawn"-/bin/sh

Then reboot.

This will disable the serial console and let you control the serial port from your program using the POSIX termios API.
7 Testing the I/O layers

7.1 devtbl

The devtbl command will print a list of the I/O layers that are detected in the module.

<table>
<thead>
<tr>
<th>Address</th>
<th>Irq</th>
<th>Model</th>
<th>Option</th>
<th>Phy/Virt</th>
<th>S/N</th>
<th>Pri</th>
<th>LogicVer</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xc9080000</td>
<td>7</td>
<td>207</td>
<td>1</td>
<td>phys</td>
<td>0027887</td>
<td>0</td>
<td>02.0c.05</td>
</tr>
<tr>
<td>0xc9090000</td>
<td>7</td>
<td>403</td>
<td>1</td>
<td>phys</td>
<td>0030384</td>
<td>0</td>
<td>02.0c.05</td>
</tr>
<tr>
<td>0xc90a0000</td>
<td>7</td>
<td>403</td>
<td>1</td>
<td>phys</td>
<td>0030385</td>
<td>0</td>
<td>02.0c.05</td>
</tr>
<tr>
<td>0xc90b0000</td>
<td>7</td>
<td>501</td>
<td>1</td>
<td>phys</td>
<td>0029693</td>
<td>0</td>
<td>02.0c.05</td>
</tr>
<tr>
<td>0xc90c0000</td>
<td>7</td>
<td>601</td>
<td>1</td>
<td>phys</td>
<td>0030279</td>
<td>0</td>
<td>02.0c.05</td>
</tr>
</tbody>
</table>

7.2 Run examples

All examples are compiled during the install process and are ready to be transferred and executed.

Compiled versions of each example are also available on the UEIPAC file system in the “/usr/local/examples” directory. There is at least one example for each supported I/O layer. Sample code examples are named “SampleXXX” (where XXX is the model ID of each layer).

To access the samples, change directory to “<UEIPAC SDK directory>/sdk/DAQLib_Samples” and copy the chosen example to your UEIPAC using one of the methods described in section 4, (e.g., telnet, ssh, etc.).

For example using FTP:

```
ftp <UEIPAC IP address>
bcd tmp
put SampleXXX
```

By default, the example uses the first I/O layer (device 0). You can change the device using command line options. The following are a few of the available options:

- `-h`: displays help
- `-d n`: selects the device to use (default: 0)
- `-f n.nn`: sets the rate of the DAQ operation (default: 1000 Hz)
- `-c "x,y,z,..."`: selects the channels to use (default: channel 0)
For example the following command runs the AI-207 test program using device 2 and channels 3, 5, and 7:

```
/tmp # ./Sample207 -d 2 -c "3,5,7"
```

There are 3 channels specified: 3 5 7

```
0: ch3 bdata 310dfff6 fdata 15.781501V
0: ch5 bdata 310dfff7 fdata 15.781501V
0: ch7 bdata 310dfff6 fdata 15.781501V

1: ch3 bdata 310dfff6 fdata 15.781501V
1: ch5 bdata 310dfff6 fdata 15.781501V
1: ch7 bdata 310dfff6 fdata 15.781501V
```

... 

All examples are configured to stop when they receive the SIGINT signal. You can send this signal by typing CTRL+C or with the following command if the program runs in the background or if you are logged on a different console than the one running the program:

```
killall –SIGINT Sample207
```

### 7.3 PowerDNA server

PowerDNA server emulates the behavior of a PowerDNA IO module running the standard DAQBIOS firmware. It emulates a subset of the DAQBIOS protocol so that the UEIPAC can be accessed from PowerDNA Explorer or the PowerDNA C API. It only works in immediate, RTDMAP and RTVMAP modes. ACB, Messaging and Asynchronous modes are not supported.

To run the PowerDNA server, type the command “pdnaserver &.”
8 Application development

8.1 Prerequisites
Verify the “<UEIPAC SDK directory>/powerpc-604-linux-gnu/bin” directory is added to your PATH environment variable. This will allow you to invoke the GCC cross compiler without having to specify its full path.

The cross compiler is required to run the different Makefiles that build the PowerDNA library and the examples (this should have been done automatically by the install script).

8.2 Compiling and running Hello World
The UEIPAC SDK comes with the GNU toolchain compiled to run on your host PC and build binaries targeting the PowerPC processor that runs on your UEIPAC.

The SDK comes with all the familiar GNU tools: ar, as, gcc, ld, objdump… To avoid confusion with a different version of those tools (for example, a version compiled to run and produce binaries for your host PC), their names are prefixed with “powerpc-604-linux-gnu-“. For example, the GNU C compiler is named “powerpc-604-linux-gnu-gcc”.

The following steps will guide you in writing your first program and running it on your UEIPAC.

1. Create a file called hello.c
2. Edit the file and enter the following text:
   
   ```c
   #include<stdio.h>
   
   int main(int argc, char* argv[])
   {
       printf("Hello World from UEIPAC\n");
       return 0;
   }
   ```

3. Compile the file with the command:
   ```
   powerpc-604-linux-gnu-gcc hello.c -o hello
   ```

4. Download the compiled program “hello” to the Cube or RACK:
   ```
   ftp <UEIPAC IP address>
   bin
   ```
5. Login on your UEIPAC using either Telnet or the serial console and type the following commands:
   
   ```
   cd /tmp
   chmod +x hello
   ./hello
   ```

   You should see the text “Hello World from UEIPAC” printed in the console window.

### 8.3 Debugging Hello World

The UEIPAC SDK contains a version of the GNU debugger compiled to run on your host PC and debug binaries targeting the PowerPC processor. Its name is “powerpc-604-linux-gnu-gdb”. The debugger allows you to debug a program remotely from your host PC.

The following steps will guide you in debugging the “hello world” program:

1. Rebuild the hello program using the –g option. This will include debug symbols in the binary file.
   
   ```
   powerpc-604-linux-gnu-gcc –g hello.c –o hello
   ```

2. Upload the new binary to the UEIPAC using FTP.

3. On the UEIPAC console, start the GDB server to debug the program remotely (It will communicate with the host on port 1234):
   
   ```
   gdbserver :1234 hello
   ```

4. On the host, start GDB and connect to the target
   
   ```
   powerpc-604-linux-gnu-gdb hello
target remote <UEIPAC IP address>:1234
   ```

5. Set the shared library search path so that GDB will find the proper library used by your program:
   
   ```
   set solib-absolute-prefix <UEIPAC Install Dir>
   set solib-search-path <UEIPAC Install Dir>/powerpc-604-linux-gnu/powerpc-604-linux-gnu/lib
   ```

   Note that this step is only necessary if you wish to step inside the code of the shared libraries. If you don’t set this variable, GDB will print a few error messages about library mismatch but you can still go ahead and debug your program.

The program is now in “running” state and GDB paused its execution. The following debug actions are available:
6. Insert a breakpoint at the beginning of the “main” function:
   
   `break main`

7. Resume execution with the `cont` command (GDB will pause the execution again when entering the “main” function).

8. Step in your program using the “n” command to step over each line of execution and “s” to step inside any called functions.

To avoid typing the same commands over and over when starting a debugging session, you can create a file named “.gdbinit” in your home directory. This file will contain commands that you want GDB to execute at the beginning of a session.

For example the following “.gdbinit” file automatically connects to the target and pauses the execution in the main function each time you start gdb:

   ```
   set solib-absolute-prefix <UEIPAC Install Dir>
   set solib-search-path <UEIPAC Install Dir>/powerpc-604-linux-gnu/powerpc-604-linux-gnu/lib
   target remote 192.168.100.2:1234
   break main
   cont
   ```

To learn how to fully use the GDB debugger, the GDB documentation is available at [http://sourceware.org/gdb/documentation/](http://sourceware.org/gdb/documentation/).

8.4 **PowerDNA Library**

The PowerDNA library implements the API used to program the PowerDNA I/O layers:

The source code is installed in “<UEIPAC SDK directory>/sdk/DAQLib”.

Examples are located in “<UEIPAC SDK directory>/sdk/DAQLib_Samples”.

The UEIPAC SDK uses a subset of the PowerDNA Software Suite API. It even allows you to control other IO modules that run the standard DAQBios firmware from the UEIPAC the same way you would from a host PC running Windows or Linux.

The PowerDNA API uses the IP address specified in the function DqOpenIOM() to determine whether you wish to access the layers local to the UEIPAC or “remote” layers installed in a remote PowerDNA IO module. Set the IP address to the loopback address “127.0.0.1” and the API will know that you want to access the “local” layers.
The PowerDNA API implements various modes to communicate with the I/O layers:

- **Immediate**: This is the easiest mode for point by point input/output on all layers. It also is the least efficient because it requires one call for each incoming and/or outgoing request. You cannot achieve maximum performance with this mode. Immediate mode examples are named “SampleXXX”

- **Data Mapping (DMAP)**: This is the most efficient mode for point by point input/output on AI, AO, DIO and CT layers. Incoming and outgoing data from/to multiple layers are all packed in a single call. DMAP mode examples are named “SampleDMapXXX”

- **Buffered (ACB)**: Allows access to AI, AO, DIO and CT layers at full speed. It is designed to correct communication errors that might happen on the network link. The error correction mechanism will cause issues with real-time deadlines. ACB mode examples are named “SampleACBXXX”

- **Messaging**: Allows access to messaging layers (serial, CAN, ARINC-429) at full speed. It is designed to correct communication errors that might happen on the network link. The error correction mechanism will cause issues with real-time deadlines. Messaging mode examples are named “SampleMsgXXX”

- **Variable Size Data Mapping (VMAP)**: Allows access to all layers at full speed, transferring incoming and outgoing data in buffers in one call. VMAP mode examples are named “SampleVMapXXX”

- **Asynchronous**: Allows I/O layers to asynchronously notify the user application upon hardware events.

The UEIPAC SDK only supports the immediate (also known as “point by point”), DMAP, and VMAP modes to control the “local” layers.

The other modes (ACB and MSG) are designed to work over Ethernet and have built-in error correction which is not needed on the UEIPAC. You can, however, use those modes to control “remote” layers installed in I/O modules that run the DAQBios firmware over the network.
8.4.1 PowerDNA API
The following section details the subset of PowerDNA APIs available when running your program on a UEIPAC.

Refer to the “PowerDNA API Reference Manual” document to get detailed information about each API.

8.4.1.1 Initialization, miscellaneous API
The following APIs are used to initialize the library, obtain a handle on the kernel driver and perform miscellaneous tasks such as translating error code to readable messages.

- DqInitDAQLib
- DqCleanUpDAQLib
- DqOpenIOM
- DqCloseIOM
- DqTranslateError
- All DqCmd*** APIs

8.4.1.2 Immediate mode API
Immediate Mode APIs are used to read/write I/O layers in a software-timed fashion. They are designed to provide an easy way to access I/O layers at a non-deterministic pace.

Each I/O layer comes with its own set of immediate mode APIs. For example, you will use the DqAdv201*** APIs to control an AI-201.

Most DqAdvXYZ*** APIs, where XYZ is the model number of a supported I/O layer, are supported on the UEIPAC.

---

<table>
<thead>
<tr>
<th>I/O Mode</th>
<th>DAQBios</th>
<th>UEIPAC (Local layers)</th>
<th>UEIPAC (Remote layers)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Immediate</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ACB</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>DMAP</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>MSG</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>VMAP</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Asynchronous</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
8.4.1.3 **DMAP API**

In DMAP mode, the UEIPAC continuously refreshes a set of channels that can span multiple layers at a specified rate paced by a hardware clock. Values read from or written to each configured channel are stored in an area of memory called the DMAP. At each clock tick, the firmware synchronizes the DMAP values with their associated physical channels.

Supported APIs that use RTDMAP mode are called DqRtDmap***.

The following is a quick tutorial on using the RTDMAP API (handling of error codes is omitted):

1. Initialize the DMAP to refresh at 1000 Hz:
   ```c
   DqRtDmapInit(handle, &dmapid, 1000.0);
   ```

2. Add channel 0 from the first input subsystem of device 1:
   ```c
   chentry = 0;
   DqRtDmapAddChannel(handle, dmapid, 1, DQ_SS0IN, &chentry, 1);
   ```

3. Add channel 1 from the first output subsystem of device 3:
   ```c
   chentry = 1;
   DqRtDmapAddChannel(handle, dmapid, 3, DQ_SS0OUT, &chentry, 1);
   ```

4. Start all devices that have channels configured in the DMAP:
   ```c
   DqRtDmapStart(handle, dmapid);
   ```

5. Update the value(s) to output to device 3:
   ```c
   outdata[0] = 5.0;
   DqRtDmapWriteScaledData(handle, dmapid, 3, outdata, 1);
   ```

6. Synchronize the DMAP with all devices:
   ```c
   DqRtDmapRefresh(handle, dmapid);
   ```

7. Retrieve the data acquired by device 1:
   ```c
   DqRtDmapReadScaledData(handle, dmapid, 1, indata, 1);
   ```

8. Stop the devices and free all resources:
   ```c
   DqRtDmapStop(handle, dmapid);
   DqRtDmapClose(handle, dmapid);
   ```
**8.4.1.4 VMAP API**

In VMAP mode, the UEIPAC continuously acquires/updates data in buffers. Each layer is programmed to acquire/update data to/from its internal FIFO at a rate paced by its hardware clock.

The content of all the layers’ FIFOs is accessed in one operation.

Supported APIs to use VMAP mode are `DqRtDmap***` and `DqRtVmap***`.

The following is a quick tutorial on using the RTVMAP API (handling of error codes is omitted):

1. Initialize the VMAP to acquire/generate data at 1kHz:
   ```c
   DqRtVmapInit(handle, vmapid, 1000.0);
   ```

2. Add channels from the first input subsystem of device 0:
   ```c
   int channels = {0, 1, 2, 3};
   DqRtVmapAddChannel(handle, vmapid, 0, DQ_SS0IN, channels, flags, 1);
   ```

3. Start all devices that have channels configured in the VMAP:
   ```c
   DqRtVmapStart(handle, vmapid);
   ```

4. Specify how much input data to transfer during the next refresh.
   ```c
   DqRtVmapRqInputDataSz(handle, vmapid, 0, numScans*sizeof(uint16), &act_size, NULL);
   ```

5. Synchronize the VMAP with all devices:
   ```c
   DqRtVmapRefresh(handle, vmapid);
   ```

6. Retrieve the data acquired by device 0:
   ```c
   DqRtVmapGetInputData(handle, vmapid, 0, numScans*sizeof(uint16), &data_size, &avl_size, (uint8*)bdata);
   ```

7. Stop the devices and free all resources:
   ```c
   DqRtVmapStop(handle, vmapid);
   DqRtVmapClose(handle, vmapid);
   ```
8.4.1.5 Event API

The event API only works when running your program on a UEIPAC. You can’t call any event function when communicating with PowerDNA over Ethernet.

The event API allows you to get notified in your application when a hardware event occurs.

The hardware events are:
- **SyncIn event**: a digital edge was sensed on the syncin pin of the Sync connector.
- **Timer event**: occurs at each tick of a hardware timer located on the CPU layer.

The following is a quick tutorial on using the event API (handling of error codes is omitted):

1. Configure hardware timer to generate an event every millisecond.
   ```c
   DqEmbConfigureEvent(handle, DqEmbEventTimer, 1000);
   ```

2. Wait for the next event. If no event occurs after 2 seconds, the function returns the event “DqEmbEventTimeout”:
   ```c
   DqEmbWaitForEvent(handle, 2000, &event);
   ```

3. Cancel the timer event:
   ```c
   DqEmbCancelEvent(handle, DqEmbEventTimer);
   ```

Refer to Appendix A. for detailed documentation of each event API function.

8.4.1.6 Unsupported APIs

All other APIs than the ones mentioned above are not supported on the UEIPAC. This includes all the ACB (DqACB***), DMAP (DqDmap***), MSG (DqMsg***), and Asynchronous (DqRtAsync*** APIs).

8.4.2 Building and running the examples

To build and run examples, change your current directory to “<UEIPAC SDK directory>/sdk/DAQLib_Samples” and type `make` to make sure that your setup can build the samples correctly.

If you get any errors while building the examples, check that the path to the cross-compiler is in your PATH environment variable and that the environment variable **UEIPACROOT** is set to the SDK directory.

You can now transfer any of the built examples to the UEIPAC, using FTP and run them.
Each example accepts command line options to specify the following parameters:

- `-d <device id>`: specify the device
- `-c <channel list>`: specify the channel list
- `-f <frequency>`: specify the rate
- `-n <number of Scans>`: specify the number of samples per channels

As an example, the following command runs the Sample201 example to acquire channels 0, 2 and 4 from device 1:

```
Sample201 -d 1 -c "0,2,4"
```

### 8.4.3 Building your own program

The first step is to compile your program, use the `–I` option to tell the compiler where the PowerDNA API headers are:

```
powerpc-604-linux-gnu-gcc –I ${UEIPACROOT}/includes –c myprogram.c
```

Then to link your program, use the `–L` option to tell the linker where the PowerDNA API library is and the `–l` option to tell the linker to link against the PowerDNA library:

```
powerpc-604-linux-gnu-gcc –L ${UEIPACROOT}/includes –l powerdna myprogram.o –o myprogram
```

The PowerDNA API is implemented in two libraries:

- `libpowerdna.so` implements the PowerDNA API for regular Linux processes
- `libpowerdna_rt.so` implements the PowerDNA API for real-time tasks

### 8.5 Real-Time Programming

The UEIPAC comes with support for the Xenomai Real-time framework (see [http://www.xenomai.org](http://www.xenomai.org)). Xenomai is a real-time development framework cooperating with the Linux kernel, in order to provide hard real-time support to user-space applications, seamlessly integrated into the Linux environment.
Xenomai uses the flow of interrupts to give real-time tasks a higher priority than the Linux kernel:

- When an interrupt is asserted, it is first delivered to the real-time kernel, instead of the Linux kernel. The interrupt will be also delivered later to the Linux kernel when the real-time kernel is done.
- Upon receiving an interrupt, the real-time kernel can schedule real-time tasks.
- Only when the real-time kernel is not running anything will the interrupt be passed on to the Linux kernel.
- Upon receiving the interrupt, Linux can schedule its own processes and threads.
- Xenomai’s real-time kernel highest priority allows it to preempt the Linux kernel whenever a new interrupt arrives with no delay and repeat the cycle.

Xenomai allows real-time tasks to run either strictly in kernel space or within the address space of a Linux process.

A real-time task in user space still has the benefit of memory protection but is scheduled by Xenomai directly instead of by the Linux kernel. The worst case scheduling latency of such kind of task is always near the hardware limits and predictable.

Using Xenomai parlance, real-time tasks are running in the primary domain while the Linux kernel and its processes are running in secondary domain.

A real-time task always starts in primary domain; however, it will jump to secondary domain (and be scheduled by the Linux kernel instead of Xenomai’s RT kernel) upon invoking a non-RT system call. Non-RT system calls are all system calls that are not implemented by Xenomai. This includes memory allocation (malloc), file access, network access (sockets), process and thread management.

You need to make sure that the time critical part of your application runs in the primary domain. One way to do this is to partition an application in two or more tasks: the high priority tasks run the time critical code and communicate with other lower-priority tasks using Xenomai’s IPC objects such as message queues and FIFOs.

The library **libpowerdna_rt**.so implements a version of the PowerDNA API that is safe to call from time critical code running in primary domain.

All real-time examples have the suffix **_rt**. For example **Sample207** is a standard Linux sample program while **Sample207_rt** is a real-time sample program.
8.6 Running a program automatically after boot

Edit the file /etc/rc.local and add an entry for any number of programs that you want to run after the UEIPAC completes the power-up sequence.

In the example below, the /etc/rc.local file is modified to run the Sample201 example at boot time.

```bash
#!/bin/sh
#
# rc.local
#
# This script is executed at the end of the boot sequence.
# Make sure that the script will "exit 0" on success or any other value on error.
#
listlayers > /etc/layers.xml
sync
devtbl

# start Sample201
/usr/local/examples/Sample201 &

exit 0
```

Note that Sample201 is executed in the background (‘&’ prefix). To stop Sample201 you must send the SIGINT signal with the following command. This is equivalent to typing CTRL+C on the console if Sample201 was running in the foreground):

```bash
killall -SIGINT Sample201
```
8.7 Running a program periodically

The UEIPAC comes with **crond** installed to periodically run scripts and programs.

Enable the init script to start **crond** at boot time:
```
mv /etc/rc.d/K30crond /etc/rc.d/S30crond
```

Add a new schedule entry to the cron configuration file:
```
crontab –e
```

Press `i` to switch to insert mode and type the new schedule entry using the following format: `<minute> <hour> <day> <month> <dayofweek> <command>`

- `<Minute>` - Minutes after the hour (0-59).
- `<Hour>` - 24-hour format (0-23).
- `<Day>` - Day of the month (1-31).
- `<Month>` - Month of the year (1-12).
- `<Dayofweek>` - Day of the week (0-6, where 0 indicates Sunday).

An asterisk in a schedule entry indicates "every". It means that the task will occur on "every" instance of the given field. So a "*" on the Month field indicates the task will run "every" month of the year. A * in the Minutes field would indicate that the task would run "every" minute.

A comma is used to input multiple values for a field. For example, if you wanted a task to run at hours 12, 15 and 18, you would enter that as "12,15,18".

As an example, the following entry will append the string “Hello UEIPAC” to the file /tmp/crontest every day at 2:30 and 15:30.
```
30 2,15 * * * echo “Hello UEIPAC” >> /tmp/crontest
```
9 Firmware installation and upgrade

9.1 Installing or upgrading the Linux kernel

Your UEIPAC comes with the Linux kernel already installed into flash memory. It is possible to update that Linux kernel if needed.

You first need to install a TFTP server on your host PC and copy the new kernel image you received from UEI technical support to the TFTP server’s directory. Kernel image files are named:

- cuImage.ueipac5200 for the UEIPAC-300 and UEIPAC-600

You can find the image of the Kernel that shipped with your UEIPAC in the folder “<UEIPAC SDK directory>/kernel”.

That same folder also contains scripts to download the kernel sources and build the kernel yourself, see Appendix G.

To start the installation or upgrade, connect to the UEIPAC through the serial port and power-up the Cube or RACK. Press any key before the 2 seconds countdown ends to enter U-Boot’s command line interface.

To continue with your installation or upgrade, follow one of the procedures provided below (choose which procedure based on which UEIPAC you have).

9.1.1 UEIPAC with Freescale 5200 CPU (100MBit Ethernet)

1. Erase the unprotected part of flash memory:
   ```
   erase ffd50000 ffefffff
   ```

2. Configure the UEIPAC’s IP address:
   ```
   setenv ipaddr <IP address of the UEIPAC>
   ```

3. Configure U-Boot to use your host PC as TFTP server:
   ```
   setenv serverip <IP address of your host PC>
   ```

4. Download the new kernel from the TFTP server:
   ```
   tftp 200000 cuImage.ueipac5200
   ```
5. Write kernel into flash (make sure you literally type “${filesize}”):
cp.b 200000 ffd50000 ${filesize}

6. Set U-Boot’s boot command to automatically boot Linux:
setenv bootcmd bootm ffd50000

7. Save environment variables to flash:
saveenv

8. Reset and boot the new kernel:
reset

9.1.2 UEIPAC with Freescale 8347 CPU (1GBit Ethernet)

1. Erase the unprotected part of flash memory:
erase fe000000 fe1fffff

2. Configure the UEIPAC’s IP address
setenv ipaddr <IP address of the UEIPAC>

3. Configure U-Boot to use your host PC as TFTP server:
setenv serverip <IP address of your host PC>

4. Download the new kernel from the TFTP server
tftp 200000 cuImage.ueipac834x

5. Write kernel into flash (make sure you literally type “${filesize}”)
cp.b 200000 fe000000 ${filesize}

6. Set U-Boot’s boot command to automatically boot Linux
setenv bootcmd bootm fe000000

7. Save environment variables to flash
saveenv

8. Reset and boot the new kernel:
reset

9.2 Initializing an SD card

Your UEIPAC is delivered pre-installed with an SD card containing the root file system
necessary to run Linux.

You might want to initialize a new SD card if the factory-installed card becomes unusable
or if you decide to upgrade to a faster or bigger one.
9.2.1 On a Linux PC
Note that you need to run Linux on your host PC to initialize an SD card. This is required because the SD card must be formatted with the ext2 file system.

Make sure automatic mounting is disabled for removable medias.

You can either type the commands below to manually format and initialize an SD card or you can run scripts included in the UEIPAC SDK to automate the procedure.

9.2.1.1 Automated Procedure
The UEIPAC SDK includes scripts to automatically partition and initialize a one or two partition SD card:

- `<ueipac sdk dir>/rfs/createsdcard.sh` creates one ext2 partitions and copies all system files.
- `<ueipac sdk dir>/rfs/createsdcard_2parts.sh` creates two ext2 partitions and copies all system files to the first one. The second partition is entirely available to store user data.
- `<ueipac sdk dir>/rfs/createsdcard_vfat.sh` creates one VFAT and one ext2 partition and copies all system files to the second one (otherwise it confuses windows and you can’t read the vfat partition on a windows PC). The first partition is entirely available to store user data.

9.2.1.2 Manual Procedure
1. Insert the SD card in a USB adapter connected to your host PC.
2. Find the name of the device node associated with the card. Type the command `dmesg` and look for a message at the end of the log similar to:
   
   `SCSI: device sdb: 1984000 512-byte hdwr sectors (1016 MB)`

   This message tells us that the device node we are looking for is “/dev/sdb”.
3. Unmount the SD card if necessary
   
   `sudo umount /dev/sdb1`
4. Erase all partitions from the SD card and create one primary partition using all the space available on the card (the example below uses a 1GB card with 1016 cylinders, use whatever default value is suggested for the last cylinder):

```
fdisk /dev/sdb
Command (m for help): d
Selected partition 1
Command (m for help): n
Command action
  e extended
  p primary partition (1-4)
p
Partition number (1-4):1
First Cylinder (1-1016, default 1):1
Last Cylinder ... (1-1016, default 1016):1016
```

```
Command (m for help): w
```

5. Unmount the SD card if necessary

```
sudo umount /dev/sdb1
```

6. The device node associated with the partition we just created is “/dev/sdb1”. Format this new partition with `mke2fs` (-j option sets file system type to ext3):

```
sudo mke2fs -j /dev/sdb1
```

7. CD to a temporary directory and untar the root file system:

```
cd /tmp
sudo tar xvfz <UEIPAC SDK directory>/rfs.tgz
```

8. Mount the new partition (on some Linux distributions it might already be mounted. Verify this with the `df` command) then copy the root file system to the SD card:

```
sudo mount /dev/sdb1 /mnt
```

```
sudo cp -rd /tmp/rfs/* /mnt
```

9. Unmount the SD card and insert it in the UEIPAC. It is now ready to boot.

```
sudo umount /dev/sdb1
```

9.2.2 On the UEIPAC itself

Boot the UEIPAC from the RAM disk instead of the SD card (follow instructions detailed in chapter 3.2).

1. Set the IP address:

```
setip <IP address of the UEIPAC>
```

2. Format the SD card:

```
mke2fs -j /dev/sdcard1
```

3. Mount the SD card:

```
mount /dev/sdcard1 /mnt
```
4. Transfer the root file system image to the UEIPAC from a Linux or Windows PC:
   `scp rfs-x.y.z.tgz root@<IP address of UEIPAC>:/mnt`

5. Uncompress the image:
   `gunzip /mnt/rfs-x.y.z.tgz`
   `tar xvf /mnt/rfs-x.y.z.tar`
   `mv /mnt/rfs/* /mnt`
   `sync`

**9.3 Running the standard DAQBios firmware**

Starting with the 2.0 release, UEIPACs come with both a Linux kernel and DAQBios firmware loaded in flash. You can select which one you want to run by setting a configuration variable in the U-Boot boot loader.

Connect to the UEIPAC through the serial port and power-up the Cube or RACK. Press any key before the 2 seconds countdown ends to enter U-Boot’s command line interface.

**9.3.1 Configure UEIPAC with Freescale 5200 CPU to run DAQBios firmware**

1. Set U-Boot’s boot command to start the DAQBios firmware automatically:
   `setenv bootcmd fwjmp`
   `saveenv`

   2. Reset and boot the DAQBios firmware:
      `reset`

**9.3.2 Configure UEIPAC with Freescale 5200 CPU to run Linux**

1. Set U-Boot’s boot command to start Linux automatically:
   `setenv bootcmd bootm ffd50000`
   `saveenv`

   2. Reset and boot the Linux kernel:
      `reset`
9.3.3 Configure UEIPAC with Freescale 8347 CPU to run DAQBios firmware

1. Set U-Boot’s boot command to start the DAQBios firmware automatically:
   ```
   setenv bootcmd go ff800100
   saveenv
   ```

2. Reset and boot the DAQBios firmware:
   ```
   reset
   ```

9.3.4 Configure UEIPAC with Freescale 8347 CPU to run Linux

1. Set U-Boot’s boot command to start Linux automatically:
   ```
   setenv bootcmd bootm fe000000
   saveenv
   ```

2. Reset and boot the Linux kernel:
   ```
   reset
   ```

10 Third-party software

10.1 Third-party libraries installed by default on UEIPAC

The libraries below typically implement C APIs that you can call from your own program.

10.1.1 zeromq

ØMQ (also known as ZeroMQ, 0MQ, or zmq) is an embeddable networking library.

10.1.2 libmodbus

Libmodbus provides a C API to implement MODBUS/TCP or MODBUS/RTU slaves and masters.

10.1.3 expat

Expat is an XML parsing library.

10.1.4 sqlite

SQLite is a software library that implements a self-contained, serverless, zero-configuration, transactional SQL database engine.
10.1.5 **gpsd**
gpsd is a utility that can listen to a GPS or AIS receiver and re-publish the positional data in a simpler format.

10.1.6 **GSL**
The GNU Scientific Library (GSL) is a numerical library for C and C++ programmers.

10.1.7 **libusb**
libusb is a C library that gives applications easy access to USB devices.

10.1.8 **mosquitto**
Mosquitto is an open source message broker that implements the MQ Telemetry Transport protocol (MQTT).

10.1.9 **audiofile**
The Audio File Library is a C-based library for reading and writing audio files in many common formats.

10.2 **Building third-party software from source**
You can install pretty much any open source software package designed for Linux on your UEIPAC provided that those software packages can be cross-compiled. The following sections describe a few standard methods of cross-compiling software packages.

10.2.1 **Software with an autoconf configure script**
Most software packages that use autoconf can be configured with the following command on a Linux PC:
```bash
./configure --host=powerpc-604-linux-gnu --build=i686-pc-linux-gnu --prefix=<root file system>
```

Use the following command on a Window/Cygwin PC:
```bash
./configure --host=powerpc-604-linux-gnu --build=i686-pc-cygwin --prefix=<root file system>
```

The configure script will then verify that the UEIPAC cross-compiler is operational and create the Makefiles required to build the software package.

To build type:
```bash
make
```
To install the built binaries, type:

```
make install
```

### 10.2.2 Other software

Read the README and INSTALL files that often come with open source packages for instructions about cross-compiling.

If there are no configure scripts and no instructions you might still be able to build a software package to run on the UEIPAC with the command:

```
CC=powerpc-604-linux-gnu-gcc
LD=powerpc-604-linux-gnu-ld
RANLIB=powerpc-604-linux-gnu-ranlib
make
```
Appendix A. Event API

A.1 DqEmbConfigureEvent

Syntax:

```c
int DqEmbConfigureEvent(int handle, DQ_EMBEDDED_EVENT event, unsigned int param);
```

Input:
- int handle: Handle to the IOM
- DQ_EMBEDDED_EVENT event: Event to configure
- unsigned int param: Event specific parameter

Return:
- DQ_ILLEGAL_HANDLE: invalid IOM handle
- DQ_SUCCESS: command processed successfully

Description:
Configure hardware to notify the specified event. Possible events are:
- DqEmbEventSyncIn: Digital edge at the syncin connector, set param to 0 for rising edge or 1 for falling edge.
- DqEmbEventTimer: Timer event, set param to desired frequency.

A.2 DqEmbWaitForEvent

Syntax:

```c
int DqEmbWaitForEvent(int handle, int timeout, DQ_EMBEDDED_EVENT *event);
```

Input:
- int handle: Handle to the IOM
- int timeout: Timeout in milliseconds
- DQ_EMBEDDED_EVENT event: Received event.

Return:
- DQ_ILLEGAL_HANDLE: invalid IOM handle
- DQ_SUCCESS: command processed successfully

Description:
Wait for any configured event to occur. If no event happens before the timeout expiration the function returns the event “DqEmbEventTimeout”.

© Copyright 2017
United Electronic Industries, Inc.
A.3  *DqEmbCancelEvent*

Syntax:

```c
int DqEmbCancelEvent(int handle, DQ_EMBEDDED_EVENT event);
```

**Input:**

- int handle
- DQ_EMBEDDED_EVENT event

**Return:**

- DQ_ILLEGAL_HANDLE  invalid IOM handle
- DQ_SUCCESS          command processed successfully

**Description:**

Cancel specified event.
Appendix B. Using Eclipse IDE to program the UEIPAC

B.1 Download and install Eclipse
There are several ways to install Eclipse with support for C/C++ programming.

If you are already using Eclipse (for Java programming for example) you can keep your existing Eclipse and just install the additional plug-ins CDT (C/C++ developer tools) and TM (target management).

Otherwise, download the Eclipse IDE for C/C++ developers package available at http://www.eclipse.org/downloads. The procedures described in this appendix are based on the Luna release of Eclipse; for other releases, the displays and instructions may vary slightly.

Unzip the package in a folder of your choice (for example “c:\eclipse\” under Windows or “/opt/eclipse” under Linux) and run the eclipse.exe program to start Eclipse.

B.2 Set up preferences
Edit Eclipse preferences to add the path to the Cygwin tools (such as make) and the UEIPAC cross-compiler.

1. Select the menu option Window » Preferences, and then in the left sidebar click C/C++ » Build » Environment. (Refer to Figure 3 below.)

2. Click Add to add a variable named PATH with value set to the Cygwin bin directory and the powerpc-604-linux-gnu/bin directory.
   For example: c:\cygwin\bin;\cygwin\home\<username>\uei\ueipac-3.2.0\powerpc-604-linux-gnu\bin

3. Click Add to add a variable named UEIPACROOT with value set to the UEIPAC SDK install directory.
   For example: c:\cygwin\home\<username>\uei\ueipac-3.2.0

4. Click Apply and then OK to store Environment variables.
B.3 **Open and build examples**

1. Select the menu option **File » New » Makefile Project with Existing Code.**

2. Type a project name.

3. Browse to the location of the example you wish to build (examples are located `<Cygwin directory>\home\<your user name>\uei\ueipac-x.y.z\sdk\DAQLib_Samples`).
4. Click **Finish** to create the project.

5. Select the **Project » Build Project** menu to build the example. Note that this build may produce errors.
The indexer will report errors about header files it can’t find.

The following procedure configures discovery options to allow the indexer to find required programs:

1. Select the menu option **Window » Preferences**.

2. In the left sidebar, select **C/C++**, and then click **Property Pages Settings**.

3. Click the **Display “Discovery Options” page** check box to enable. (Refer to Figure 6 below)

4. Click **OK**.
5. Select the menu option **Project » Properties** and in the left sidebar, click **C/C++ Build » Discovery Options**.

6. Verify **Automate discover of paths and symbols** is checked, and **Discovery profile** is set to **Managed Build System – per project**. (Refer to Figure 7 below).

7. Change the compiler invocation commands to `powerpc-604-linux-gnu-g++` and `powerpc-604-linux-gnu-gcc`:
8. Check **Show output in a dedicated console in the Console view** to see output messaging in the Eclipse Console pane.

9. Click **Apply** and **OK**. The indexer will automatically find all header files next time you build the project.

**B.4 Download a program to target**

The following procedure describes how to add a **Remote Systems** view to your current perspective.

1. Select the menu option **Window » Show View » Other…**

3. In the **Remote Systems** pane, click the **Define a connection to a remote system** button (refer to the following image for the icon location):
4. Select **Linux**, and then click **Next**.

5. Enter the IP address of your UEIPAC as **Host Name** and pick a **Connection name**.

6. Click **Next**.
NOTE: This example uses FTP to transfer files to/from the UEIPAC.

7. Select ftp.files.

8. Select FTP Connector Service » FTP Settings, and set the FTP passive setting to true.

9. Click Next.
NOTE: This example uses a remote shell to control the processes running on the UEIPAC.

10. Select `processes.shell.linux` and click Next.
NOTE: This example uses SSH as remote shell to control the UEIPAC.

11. Select `ssh.shells` and click **Finish**.

The UEIPAC will appear in the **Remote Systems** pane.

The connection can be tested by navigating files on the UEIPAC file system:

1. Click **UEIPAC » Files**, and double-click **Root**. An **Enter Password** window will open.
2. Enter "root" as **User ID** and **Password**, and then click **OK**.
3. In the Remote Systems panel, select **UEIPAC** » **Shell Process** » **All Processes** to view the processes running on the UEIPAC. The UEIPAC file system can be navigated under **UEIPAC** » **Files** » **Root**, as shown below.
4. Right-click UEIPAC » Ssh Terminals, and select Launch Terminal to open a remote shell session on the UEIPAC.

B.5 Execute a program

1. Select the Run » Run Configurations... menu option to open the Run dialog box.

2. Select the C/C++ Remote Application option, and press the New button to create a new remote launch configuration. The Create, manage, and run configurations Sample pane will open:
3. Enter a name for this new launch configuration.

4. Set the Connection to **UEIPAC** as previously defined.

5. Verify that the project is set properly or press **Browse…** to select the right project.

6. Verify that the **C/C++ Application** is set to the binary built from your project.

7. Set the **Remote Absolute File Path** to the path of the executable on the remote target.

8. Click **Apply**, and then click **Run** to download the binary to the UEIPAC and execute it. You will see the result in the Console:
B.6 Debugging your program on the UEIPAC

The UEIPAC examples are already compiled with debug information. Make sure that your program is compiled with debug options, too (add the option \texttt{-g} to the compiler flags).

1. Select the Run » Debug Configurations… menu option to open the Debug dialog box.

2. Select the C/C++ Remote Application » <Sample name> previously created. In this example, we use Sample207.

3. In the Debugger tab, set GDB debugger to \texttt{powerpc-604-linux-gnu-gdb}.
4. Click **Debug** to download the program to the UEIPAC and start debugging it.

5. Eclipse will suggest that you switch to the **Debug perspective**, click **Yes**
The debugger will pause the program execution at the beginning of main().

Set a breakpoint on a line in main() (Right-click the line and select **Toggle breakpoint**) then press **F8** to resume execution.

The debugger will pause the program again at the line where the breakpoint was set.
You can now execute the program step by step pressing the keys F5 and F6.

More information about debugging programs is available in Eclipse’s online help. Select the menu option Help » Help Contents.
Debugging a project

The debugger lets you control the execution of your program by setting breakpoints, suspending executed programs, stepping through your code, and examining the contents of variables.

To debug a project:

1. Click Run > Debug. The Debug window opens.
2. Double-click C++ Local Application.
3. In the Name field, type Hello World. You can now select this debug launch configuration by name the next time that you debug this project.
4. In the Project box, type hello.exe.
5. Click Debug. You will now see the debug perspective with the hello.exe application window open. The C/C++ editor repositions in the perspective.

http://127.0.0.1:51395/help/topic/org.eclipse.cdt.doc.user/getting_started/cdt_w_debug.html
Appendix C. Creating a new Eclipse project for UEIPAC

The following procedure creates a new UEIPAC project in Eclipse. If you are downloading Eclipse for the first time or setting up Eclipse for UEIPAC projects that already have existing code, please refer to above.

C.1 Create a new project

1. Select the menu option File » New » C++ Project.

2. Enter a Project name, select Cross GCC and click Next.
3. Enter Author and basic properties in the Basic Settings window, and click Next.

4. Click Next in the Select Configurations window. Paths will be configured in a later step.

5. In the Cross GCC Command window, set prefix to powerpc-604-linux-gnu- (don’t forget the ‘-‘ at the end of the prefix).

6. Set path to <UEIPAC SDK folder>/powerpc-604-linux-gnu/bin, and then click Finish.
C.2 Configure the environment

Eclipse needs to know where the make utility and the compiler binaries are located (even though they were already set during the project configuration).

1. In the Project Explorer pane, right-click your project and select Properties.

2. Select C/C++ Build, and then click Environment.

3. Edit PATH and append \cygwin\bin;\cygwin\home\<username>\uei\ueipac-x.y.z\powerpc-604-linux-gnu\bin; to the existing value.

4. Click OK.

5. Click Apply, and then OK.
C.3  Build and run

1. Select the Run » Run Configurations… menu option to open the Run dialog box.

2. Select the C/C++ Remote Application option, and press the New button to create a new remote launch configuration:
3. Verify that the **C/C++ Application** is set to the binary built from your project. (This is set to Debug\HelloUEIPAC in the example below).

4. Enter the path and name in the **Remote Absolute File Path for C/C++ Application** to set the location where the application should be uploaded on the UEIPAC file system. (This is set to /tmp/HelloUEIPAC in the example below).

5. Click **New…** to create a new Connection.
6. Select **Linux**, and click **Next**.
7. Enter the IP address of your UEIPAC as **Host Name** and pick a **Connection name**.

8. Click **Next**.
9. Select **ftp.files**, and click **Next**

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>ftp.files</td>
<td>Property</td>
</tr>
<tr>
<td></td>
<td>parser</td>
</tr>
<tr>
<td></td>
<td>passive</td>
</tr>
</tbody>
</table>

**Available Services**

- FTP File Service
- FTP Connector Service
- FTP Settings

**Description**

![Diagram of connection configuration with selected options and properties]
10. Select `processes.shell.linux`, and click Next.
11. Select **ssh.shells**, and click **Finish**.

**New Connection**

**Shells**

Define subsystem information

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Available Services**

- Generic shell service
- SSH Connector Service
  - SSH Settings

**Description**

Work with shells and commands on remote systems using the Secure Shell (ssh) protocol.
12. Change the connection from Local to the connection set up in step 7:

13. Click **Apply**, and then **Run** to upload and run your program.
14. In the Enter Password window, type “root” for the User ID and Password:

![Enter Password Window]

15. Verify the output in the Console pane:
C.4 Adding DNA API calls to your program

1. Right-click your project, and select Properties.

2. Select C/C++ Build, and then click Settings.

3. Click Cross GCC Compiler » Includes and add an include path set to c:\cygwin\home\<username>\uei\ueipac-x.y.z\include.

4. Click Cross G++ Compiler » Includes and add an include path set to c:\cygwin\home\<username>\uei\ueipac-x.y.z\include.
5. Click **Cross G++ Linker » Libraries** and add a library set to **powerdna** and library search path set to `c:\cygwin\home\uei\ueipac-x.y.z\lib`.

Add PowerDNA library calls to your code, build and run
Appendix D. Booting from NFS

D.1 Configure shared RFS on host PC

1. Install an NFS server on your Linux machine.

2. Untar the rfs.tgz file that comes on the UEIPAC CD-ROM.

3. Share the rfs directory (usually done by adding an entry in the /etc/exports file)
   /etc/exports file should look like this:
   
   /home/frederic/UEIPAC/rfs
   192.168.100.0/255.255.255.0(rw,sync,no_subtree_check,no_root_squash)

4. Remove the file rfs/etc/rc.d/S10network (kernel does the network configuration
   while booting and overwriting it will kill the NFS session).

5. Create the directory rfs/etc/mnt (used to mount the SD card later).

6. Edit the file rfs/etc/fstab and change the mount point for /dev/sdcard1 to /mnt
   rfs/etc/fstab should look like this:
   
   /dev/sdcard1 /mnt ext2 defaults,noatime 1 1
   none /proc proc defaults 0 0
   none /sys sysfs defaults 0 0
   none /dev/pts devpts defaults 0 0

   This will make the SD card accessible under /mnt when the UEIPAC boots over
   NFS.

D.2 Configure U-Boot

1. Power-up the UEIPAC and press a key to enter U-Boot.

2. Type the following to set the console type, which depends on what type of CPU is
   in your UEIPAC:
   For UEIPAC 300, UEIPAC 600 models (based on 5200 CPU):
   setenv consoledev ttyPSC0

   For all other UEIPACs (1G Cubes and R/F RACK models based on 8347 CPU):
   setenv consoledev ttyS0
3. Type the following commands:
   setenv gateway <your gateway ip address>
   setenv netmask <your netmask>
   setenv baudrate 57600
   setenv netdev eth0
   setenv rootpath <The remote path where rfs is located on your host PC>
   run nfsargs
   run addip
   setenv bootargs ${bootargs} console=${consoledev},${baudrate}
   saveenv
   printenv

4. Verify that your bootargs variable looks like this:
   For UEIPAC 300, UEIPAC 600 models (based on 5200 CPU):
     bootargs=root=/dev/nfs rw
     nfsroot=192.168.100.1:/home/frederic/UEIPAC/rfs
     console=ttysPSC0,57600
     ip=192.168.100.2:192.168.100.1::255.255.255.0::eth0:off panic=1
   For all other UEIPACs (1G Cubes and R/F RACK models based on 8347 CPU):
     bootargs=root=/dev/nfs rw
     nfsroot=192.168.100.1:/home/frederic/UEIPAC/rfs
     console=ttys0,57600
     ip=192.168.100.2:192.168.100.1::255.255.255.0::eth0:off panic=1

5. Reset the UEIPAC which will now find its root file system on the NFS share
   reset
Appendix E. Building the Linux kernel

E.1 Download and patch Linux source

Note that you can only build the UEIPAC Linux kernel on a PC running Linux connected to the internet.
Verify that you have the following tools installed:
- git
- make
- patch
- UBoot mkimage

Use the package manager of your Linux distribution to install those tools.

For example, use the following commands on Ubuntu:
- sudo apt-get install git
- sudo apt-get install make
- sudo apt-get install patch
- sudo apt-get install uboot-mkimage

At a command prompt, change the current directory to `<UEIPAC SDK directory>/kernel`

The UEIPAC kernel includes a Xenomai real-time extension. The first step is to download and build Xenomai.

Run the `build_xenomai.sh` script.
```
./build_xenomai.sh
```

Then run the `get_kernel.sh` script with the option `–cpu` set to the CPU of your UEIPAC:

For UEIPAC-300, UEIPAC-600:
```
./get_kernel.sh –cpu 5200
```

For all other UEIPACs:
```
./get_kernel.sh –cpu 834x
```

This script might take a long time to execute depending on the speed of your internet connection.
Once the script is finished, you will find a new directory `linux-DENX-v2.6.28.5` containing the kernel source with Xenomai and UEIPAC patches applied.

**E.2 Configure and build the kernel for UEIPAC-300 and UEIPAC-600**

Change the current directory to the Linux source directory.

1. Configure kernel with default settings:
   ```
   make ARCH=powerpc CROSS_COMPILE=powerpc-604-linux-gnu-52xx/ueipac5200_defconfig
   ```

2. Customize kernel configuration:
   ```
   make ARCH=powerpc CROSS_COMPILE=powerpc-604-linux-gnu-menuconfig
   ```

3. Compile the kernel:
   ```
   make ARCH=powerpc CROSS_COMPILE=powerpc-604-linux-gnu-cuImage.ueipac5200
   ```

You can find the build kernel in `arch/powerpc/boot/cuImage.ueipac5200`.

**E.3 Configure and build the kernel for UEIPAC-300-1G, UEIPAC-600-1G and RACK versions**

Change the current directory to the Linux source directory.

1. Configure kernel with default settings:
   ```
   make ARCH=powerpc CROSS_COMPILE=powerpc-604-linux-gnu-83xx/ueipac834x_defconfig
   ```

2. Customize kernel configuration:
   ```
   make ARCH=powerpc CROSS_COMPILE=powerpc-604-linux-gnu-menuconfig
   ```

3. Compile the kernel:
   ```
   make ARCH=powerpc CROSS_COMPILE=powerpc-604-linux-gnu-cuImage.ueipac834x
   ```

4. Compile modules:
   ```
   make ARCH=powerpc CROSS_COMPILE=powerpc-604-linux-gnu-modules
   ```

5. Install modules:
   ```
   make ARCH=powerpc CROSS_COMPILE=powerpc-604-linux-gnu-modules
   ```
INSTALL_MOD_PATH=<Your module install path>
modules_install

You can find the built kernel in arch/powerpc/boot/cuImage.ueipac834x and the modules in whatever directory you assigned to the INSTALL_MOD_PATH variable.
Appendix F. Converting root file system to read only

F.1 Modify RFS on SD card

1. Edit /etc/fstab as follow to mount a ram disk at /var (ram disk maximum size is set to 2MBytes):

   /dev/sdcard1    /           ext3    defaults,noatime 1 1
   none           /proc       proc    defaults          0 0
   none           /sys        sysfs   defaults          0 0
   none           /dev/pts    devpts  defaults          0 0
   tmpfs          /var        tmpfs   defaults,size=2M 0 0

2. Create a new script /etc/varsetup.sh with the content below. It sets up the folders needed in /var and maps a few writable folders at /tmp, /mnt and /home

   mkdir /var/tmp
   mkdir /var/log
   mkdir /var/lib
   mkdir /var/lib/misc
   mkdir /var/spool
   mkdir /var/spool/cron
   mkdir /var/spool/cron/crontabs
   mkdir /var/run
   mkdir /var/lock
   mkdir /var/mnt
   mkdir /var/home

   mount --bind /var/tmp /tmp
   mount --bind /var/mnt /mnt
   mount --bind /var/home /home

3. Edit /etc/inittab as follow to execute varsetup.sh

   # Mount all filesystem listed in /etc/fstab
   ::sysinit:/bin/mount -a

   # Create and mount non-persistent folders
   ::sysinit:/etc/varsetup.sh

   # Configure local network interface
   ::sysinit:/sbin/ifconfig lo 127.0.0.1 up
   ::sysinit:/sbin/route add -net 127.0.0.0 netmask 255.0.0.0 lo

   # run rc scripts
   ::sysinit:/etc/rcS
# Start a shell on the console
ttyS0::respawn:-/bin/sh

# unmount root file system when shutting-down
::shutdown:/bin/umount -a -r

4. Create symbolic links to files stored in /etc that need to be kept writeable.

    ln –s /var/resolv.conf /etc/resolv.conf
    ln –s /var/layers.xml /etc/layers.xml

F.2 Configure U-Boot

1. Connect the console serial port, power-up the UEIPAC and press a key to enter U-Boot.

2. Type the following commands to load the root file system as read-only:

    setenv bootargs console=ttyS0,57600 root=62:1 ro
    saveenv
Appendix G. Updating RAM disk image

The UEIPAC software CDROM contains a RAM disk image uRamdisk-x.y.z that you can upload to flash and boot from on 1G and R UEIPAC models (see section 3.2).

This appendix explains how to modify this image to add your own files (typically your program and associated configuration files).

This operation can only be done on a Linux workstation. You also need to install the uboot mkimage utility. For example, with Ubuntu type:

```
bash$ sudo apt-get install uboot-mkimage
```

1. Extract compressed RAM disk image from uImage file. The following command converts the file uRamdisk-x.y.z to ramdisk.gz:

```
bash$ dd if=uRamdisk-x.y.z bs=64 skip=1 of=ramdisk.gz
21876+1 records in
21876+1 records out
```

2. Uncompress RAM disk image:

```
bash$ gunzip -v ramdisk.gz
ramdisk.gz:      66.6% -- replaced with ramdisk
```

3. Mount RAM disk image:

```
bash$ mount -o loop ramdisk /mnt/tmp
```

Now you can add, remove, or modify files in the /mnt/tmp directory. Once you are done, you can re-pack the RAM disk into a U-Boot image:

1. Unmount RAM disk image:

```
bash$ umount /mnt/tmp
```

2. Compress RAM disk image:

```
bash$ gzip -v9 ramdisk
ramdisk:         66.6% -- replaced with ramdisk.gz
```

3. Create new U-Boot image:

```
bash$ mkimage -T ramdisk -C gzip -n 'UEIPAC RAM disk' -d
```
ramdisk.gz new-uRamdisk-x.y.z
Image Name: UEIPAC RAM disk
Created: Wed Apr 11 17:32:41 2012
Image Type: PowerPC Linux RAMDisk Image (gzip compressed)
Data Size: 2425561 Bytes = 2368.71 kB = 2.31 MB
Load Address: 0x00000000
Entry Point: 0x00000000
Appendix H. Bonding/Teaming Ethernet ports

Teaming/Bonding describes various methods to combine multiple network links in parallel to provide redundancy and/or increase data throughput.

This chapter describes the configuration of a fault tolerant link between a UEIPAC and a host PC. Bonding is only possible on UEIPACs equipped with two independent network ports.

In this mode, only one network adapter (the primary) is active. The secondary adapter takes over as soon as it detects that the primary adapter can't connect to its peer.

1. Power-up your UEIPAC and open a serial terminal program.
2. Tear-down existing network connections.
   
   ```
   ifconfig eth0 down
   ifconfig eth1 down
   ```

3. Load bonding kernel module with parameters set to the following:
- monitor the link to the host PC every 500ms
- fault tolerance mode
- use eth0 as primary connection

```bash
modprobe bonding arp_ip_target=192.168.103.1 arp_interval=500
mode=active-backup primary=eth0
```

4. Bring-up **bond0** connection.

```bash
ifconfig bond0 up
```

5. Assign **eth0** and **eth1** as slaves to **bond0**.

```bash
ifenslave bond0 eth0 eth1
```

6. Configure an IP address for **bond0**.

```bash
ifconfig bond0 192.168.103.2 netmask 255.255.255.0
```